
O P E R AT I O N / C O N F I G U R AT I O N

C2675M-B (7/09)

Client Software Application

DX4500/DX4600
Digital Video Recorder 



Contents

Introduction

Welcome to the DX4500/DX4600 Client Application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Client Application Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Application Scenario. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
Video Quality Caution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Upgrade Policy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
Software Upgrades. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Installation

Getting Started  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Recommended System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Minimum PC Requirement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Recommended PC Requirements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Installing the Client Application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Getting Acquainted

Application Window  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Menu Bar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

File Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
View Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
Help Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

GUI Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
View Panes and Panels. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Site tree  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
PTZ Control Toolbar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Live View On-Screen Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Playback Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Playback . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Playback Speed and Volume . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Playback Timeline  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Operating Modes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Client Application  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
Starting the Client Application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
Connecting to and Logging On to a Remote Site . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Logging Off from a Remote Site . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

Automatically Connecting to a Remote Site . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
Disconnecting from a Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
Exiting the Client Application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

DX4500/DX4600 Export Viewer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
Getting Started . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

Starting the Export Viewer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
Changing the Language . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
Exiting the Export Viewer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
Exported Video File Naming Convention . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

Viewing Exported Video . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Verifying the Watermark  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
2 C2675M-B (7/09)



Set Up

Setup Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

Camera Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
Configuring Cameras  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
PTZ Communication  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
Configuring Motion. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
Display Characteristics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Schedule Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
Schedules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

Daily Recording Schedule . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Copying Schedules. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Holiday Schedules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

Configuring Channel Image Rate Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
Configuring Record Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
Configuring Multi-Event Record Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

Linking Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
Alarm Inputs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

Network Setup. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
TCP/IP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
DDNS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
Notification . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Mail . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Emergency Notification  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

System Setup. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
Date and Time. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
Sound  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
User Accounts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

Changing the Administrator User Password . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
Adding a New User . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
Editing a User. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
Deleting a User  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

Hard Disk. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
Auto User Logout  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62

Operation

Live Video. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
Navigating View Panes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
Assigning Cameras to View Panes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
Repositioning or Replacing Cameras in View Panes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

Live View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Customizing the On-Screen Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Sequence Dwell Time. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

Selecting the Sequence Dwell Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Starting and stopping the Sequence View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

Full Screen View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
Selecting a Language . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
Viewing HDD Information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
Viewing the System Log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

PTZ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
PTZ Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

Adjusting the Camera Zoom, Focus, and Iris. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
C2675M-B (7/09) 3



PTZ Presets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
Programming a Preset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
Activating a Preset. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
Clearing a Preset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

Preset Tours  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
PTZ Patterns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

Programming a Pattern  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
Activating and Clearing a Pattern . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

Accessing Programming Features of Remote Cameras . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
Remote Camera Programming Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

Sending Auxiliary Commands to a Device . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

Playback Video. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
Recorded Video and Audio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
Playback Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
Save Video Screen Capture to JPEG Format  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76

Search Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
Date/Time Search Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
Date/Time Search  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
Bookmark Search  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81

Event Search  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
Pixel Search . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83

Backup Search  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
Select a Backup Media Device . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
Search Backup Media for Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86
Exit Backup Search Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

Export Mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87
Export Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87
Exporting Standard Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89
Exporting DST Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

Exporting Data Recorded During DST . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
Exporting Data Recorded Before and During DST. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
Exporting Data Recorded During and After DST . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92
Incorporating Both DST Hours (DST On, DST Off) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92

Exporting Data from the DX4000 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93

Recorded Video and Audio  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
Live View. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
Search Mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96
Printing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96

Printing from the Live View Mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96
Printing from the Search Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97

Remote Server Sites  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
Adding Remote Sites  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
Editing a DVR Server Site . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99
Deleting a Remote Site. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101

Supplemental Applications

Emergency Agent. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
Getting Started . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

Starting the Emergency Agent. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
Displaying the Emergency Agent Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
Real-Time Event Monitoring. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
Emergency Agent Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

Selecting the Language . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
Configuring the Network Port . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

Real-Time Event Monitoring. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104
4 C2675M-B (7/09)



Received Messages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104
Viewing Message Details . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104
Performing a Message Search  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
Deleting an Event Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
Exiting the Emergency Agent. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

Web Client . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106
Getting Started . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106

Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106
Starting the Web Client . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
Exiting the DX4500/DX4600 Web Client . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
Remote Sites. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109

Logging On to a Remote Site. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Logging Off From a Remote Site . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Viewing Video . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109

Appendix
Time Zone Conversion Chart. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110
C2675M-B (7/09) 5



List of Illustrations

 1 Sample DX4500/DX4600 Application Scenario . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
 2 Client Application Window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
 3 View Panes and View Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
 4 Site Tree  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
 5 PTZ Control Toolbar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
 6 PTZ OSD Menu Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
 7 Live View OSD Pane . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
 8 Playback Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
 9 Playback Speed and Volume Controls  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

 10 Playback Timeline . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
 11 Client Password Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
 12 Application Window and Connection List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
 13 Remote Login Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
 14 Logging Off from a DX4500/DX4600 Remote Site . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
 15 Logging Off from a DX4000 Remote Site . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
 16 Selecting Auto Connect  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
 17 Disconnecting from a DVR Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
 18 Export Viewer Application Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
 19 Exported Video File Naming Convention . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
 20 Open Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
 21 Altered Video Message  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
 22 DX4500/DX4600 Setup Window and Default Camera Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
 23 DX4000 Settings Window  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
 24 Camera Page Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
 25 PTZ Communication Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
 26 Motion Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
 27 Display Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
 28 Schedule Page Options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
 29 Select a Recording Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
 30 Copying a Schedule  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
 31 Holiday Schedule  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
 32 Holiday Calendar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
 33 Holiday List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
 34 Scheduling Holiday Recording . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
 35 Creating a Special Day Schedule . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
 36 Record Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
 37 Default Record Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
 38 Alarm Record Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
 39 Linking Page Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
 40 Network Page Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
 41 Bandwidth Throttle Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
 42 DDNS Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
 43 Mail Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
 44 Emergency Agent Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
 45 System Page Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
 46 Setting the Date and Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
 47 Selecting the Administrator-Level User . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
 48 User Setting Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
 49 List of Users and Levels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
 50 Adding a User to the User List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
 51 Overwrite Drop-Down Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
 52 Full Warning Drop-Down Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
 53 Auto User Logout Drop-Down Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
 54 Client Application Window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
 55 Division Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
 56 Repositioning or Replacing a Camera  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
 57 Client OSD Menu Options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
 58 Setting Sequence Dwell Time  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
 59 Full Screen View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
C2675M-B (7/09) 6



 60 Selecting a Language . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
 61 HDD Information Dialog Box. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
 62 Log View Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
 63 System Log Search Results  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
 64 On-Screen PTZ Control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
 65 On-Screen PTZ Direction Arrows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
 66 PTZ Control Toolbar with Camera Lens Controls  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
 67 PTZ Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
 68 Camera Setup Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
 69 Keypad Buttons 1–4 are Available . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
 70 Playback Timeline in 24-Hour View  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
 71 Playback OSD . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
 72 Date Drop-Down Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
 73 Disable Audio Button . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
 74 Export Dialog Box_C2675M-B-1001.tif  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
 75 Client Search Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
 76 Date/Time Search . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
 77 Bookmark Search  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
 78 Bookmark Search Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
 79 Event Search . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
 80 Event Search Results  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
 81 Pixel Search  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83
 82 Accessing DX4000 Backup Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
 83 Browsing to the Media . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
 84 Backup Search Name . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
 85 Media Displayed in Backup Search Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85
 86 Backup Search Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85
 87 Client Export Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88
 88 Configuring the Date/Time Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89
 89 Export Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90
 90 Configuring the DST Date/Time Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
 91 Export Entry Added to the Export Table  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92
 92 DX4000 Export Date/Time Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93
 93 Export Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
 94 Disabled Audio Icon . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
 95 DX4500/DX4600 Connection Setup Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
 96 DX4000 Connection Setup for Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
 97 Adding Servers to the Connection List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99
 98 Servers Displayed in Site Tree . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99
 99 Connection List Dialog Box. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100
 100 Connection Setup Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100
 101 Editing a Remote Site Name  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100
 102 Starting the Emergency Agent . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
 103 Emergency Agent Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
 104 Emergency Agent Message . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
 105 Emergency Agent Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
 106 Option Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
 107 Received Messages Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104
 108 Selecting Event Type Search Criteria . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
 109 ActiveX Installation Message. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106
 110 ActiveX Submenu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106
 111 Security Warning Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
 112 Remote Login Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
 113 Web Client Application Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
C2675M-B (7/09) 7



8 C2675M-B (7/09)

List of Tables

A File Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
B View Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
C Help Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
D GUI Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
E Client Operating Modes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
F DX4500/DX4600 Third-Party PTZ Compatibility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
G TCP/IP Ports Used by the DX4500/DX4600 and Client Application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
H User Levels and Permissions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
I System Events Log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
J Web Client Toolbar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
K Time Zone Conversion Chart. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110



Introduction

Welcome to the DX4500/DX4600 Client Application
A fully featured and fully affordable entry-level digital video recorder (DVR), the DX4500/DX4600 Series DVR is the next generation in DVRs. 
Equipped with an embedded operating system, it offers camera capacity, features, and functionality exceeding other DVRs. The DX4500/DX4600 
is designed for the entry-level market that requires 8 or 16 camera inputs; greater internal hard drive storage capacity; fast frame rate recording; 
and powerful playback, search, and export capability. The DX4500/DX4600 not only replaces the traditional VCR and multiplexer combination, 
but it also offers the benefits derived from the latest in digital video processing.

Designed to work with today’s broadband networks, the DX4500/DX4600 uses MPEG-4 compression, allowing you to view and control the DVR 
across local or wide area networks. Recording at resolutions of up to 704 x 480 (4CIF), the DX4500/DX4600 captures crystal clear pictures, 
creating effective footage for later use and retrieval. The Client application allows you to capture a still video image and saved screen capture in 
JPEG format to a location on the remote client PC hard drive. Backup search allows you to locate and view video backed up at the
DX4500/DX4600 server. Video can be backed up to a USB drive, CD, or DVD. You can also copy the backed up data from the media to the Client 
PC’s hard drive. Exported video is easily reviewed at the DX4500/DX4600 server or using the Export Viewer. Each DVR input channel can be 
configured individually to meet a specific security application requirement for video retention. Video critical to investigation and archiving is 
easily exported to a USB memory device or to an optional CD-RW or DVD±RW device.

Operation of the DX4500/DX4600 server is made easy through the front panel, remote control keypad, or USB mouse. The remote DX4500/
DX4600 Client application can interface with up to sixteen DX4500/DX4600 servers simultaneously. User-configurable disk partitioning is used to 
allocate specific hard disk space for storing continuous video data and event-initiated video data. The retention time can be different for 
retaining continuous recorded video and event-initiated recorded video.

For surveillance applications requiring PTZ capability, the DX4500/DX4600 addresses and controls pan, tilt, and zoom (PTZ) equipment such as 
Spectra® domes and Esprit® positioning systems, or third-party cameras. The DX4500/DX4600 supports Pelco C (Coaxitron®), Pelco D, and 
Pelco P protocols. A KBD300A keyboard can be connected at the DX4500/DX4600 sever to control PTZ devices. Multi-event recording includes 
any single or combination of events associated with an instant, alarm, or motion recording event. The DX4600 allows you to schedule each 
camera to record in a single or multiple-event mode across a 24-hour timeline. You can also configure each camera to record at a specific 
resolution, quality, and image rate when an event is triggered. 

The DX4500/DX4600 video outputs provide for efficient control and effective deterrence. The choice of VGA or composite main monitor output 
provides flexibility for the user. The main monitor output can be adjusted to display one, four, nine, or sixteen cameras, or it can be adjusted for a 
custom display. The DX4500/DX4600’s spot monitor output can be used for public viewing or alarm call-up.

The DX4500/DX4600 is designed to deliver robust and reliable performance for security professionals. From the incorporation of watermarking 
technology to prevent alterations to captured video, to the ability to capture log entries, to the inclusion of Pelco’s world.

CLIENT APPLICATION SOFTWARE
DX4500/DX4600 software runs on two platforms:

• The DX4500/DX4600 server software runs on the DX4500/DX4600 Series DVR. 

• The DX4500/DX4600 Client Application software runs on a personal computer (PC) and allows you to log on to and operate the DX4500/
DX4600 server system from your local PC. 

Fully implemented networking capabilities allow remote viewing of live video, playback, and administration of DVR server features. Versatile 
high-speed search operations include time and date, bookmark, event, and pixel searching. Extensive scheduling features allow customizing of 
day, weekday, weekend, and special event recording. The DX4500/DX4600 provides a graphical user interface (GUI), allowing for quick and 
efficient access to setup and operating features.

The DX4500/DX4600 also includes the following PC-based applications:

• DX4500/DX4600 Export Viewer: The Export Viewer allows you to play back video exported from the DX4500/DX4600 server. The Export 
Viewer will recognize and verify the digital watermark that is embedded in DX4500/DX4600 native video. Watermarking is used to 
authenticate the originality of a video file and alert users to possible image tampering. The Export Viewer application starts automatically 
each time a CD or DVD created by the DX4500/DX4600’s export feature is inserted into a Microsoft® Windows®-based PC. The software 
can also be installed on a PC and opened independently when necessary.

• DX4500/DX4600 Client Emergency Agent: The DX4500/DX4600 Client Emergency Agent works with networked DX4500/DX4600s to 
alert users when one or more channels detects an event (for example motion, alarm, video loss, and so forth).
C2675M-B (7/09) 9



• DX4500/DX4600 Web Client: The DX4500/DX4600 Web Client allows you to view live video and operate pan, tilt, and zoom (PTZ) 
features of cameras attached to DX4500/DX4600. Using a standard Web browser, you can remotely monitor up to 16 cameras from one 
DX4500/DX4600 server. Each DX4500/DX4600 server can support up to five connections, consisting of Web clients and Client applications, 
either internally within an organization or externally through the Internet.

APPLICATION SCENARIO
As the next generation DVR, the DX4500/DX4600 is the solution for small- to multiple-site applications. The remote client-to-server connectivity 
allows operation from a remote location and application can connect up to sixteen DX4500/DX4600 servers simultaneously. The remote client is 
used to operate and administer individual servers. Cameras from the networked servers are easily dragged and dropped on to the remote Client 
application window for viewing up to 16 images simultaneously. 

Figure 1.  Sample DX4500/DX4600 Application Scenario

IMPORTANT NOTE. PLEASE READ. The network implementation in this document is shown as a general representation only and is not 
intended to show detailed network topologies. Your actual network will differ, requiring changes or perhaps additional network equipment to 
accommodate the system as illustrated. Please contact your local Pelco representative to discuss your specific requirements.

VIDEO QUALITY CAUTION
FRAME RATE NOTICE REGARDING USER-SELECTED OPTIONS

Pelco systems are capable of providing high quality video for both live viewing and playback. However, the systems can be used in lower quality 
modes, which can degrade picture quality, to allow for a slower rate of data transfer and to reduce the amount of video data stored. The picture 
quality can be degraded by either lowering the resolution, reducing the picture rate, or both. A picture degraded by having a reduced resolution 
may result in an image that is less clear or even indiscernible. A picture degraded by reducing the picture rate has fewer frames per second, 
which can result in images that appear to jump or move more quickly than normal during playback. Lower frame rates may result in a key event 
not being recorded by the system.

Judgment as to the suitability of the products for user’s purposes is solely the user’s responsibility. Users shall determine the suitability of the 
products for their own intended application, picture rate and picture quality. In the event user intends to use the video for evidentiary purposes in 
a judicial proceeding or otherwise, user should consult with its attorney regarding any particular requirements for such use.
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Upgrade Policy
Pelco’s representations regarding product features and performance are limited to those made in the specification sheet and installation/
operation manuals at the time the product was manufactured. Pelco does not represent or warrant that any upgrades to product hardware or 
software will be made available in the future. When possible, Pelco will offer product upgrades to purchasers of its products. 

SOFTWARE UPGRADES
1. All upgrades for Pelco software shall be free to the customer for the duration of the warranty period. This offer does not apply to software 

that may be installed in a Pelco product that is licensed from another supplier. All other software, such as operating systems, drivers for 
accessory devices, and so forth, shall be governed by the software manufacturer’s upgrade policy, even when said upgrades are necessary 
to implement an upgraded version of Pelco software.

2. Whenever possible, software upgrades with detailed instructions shall be provided to the customer through Web site download. Pelco will 
not be responsible for loss of data, losses due to downtime, or damage to product as a result of a customer attempting to perform an 
upgrade.

3. Hard copies on appropriate medium (CD/DVD, ZIP, or floppy disk) shall be sent to the customer at no charge upon request.

4. It shall be the customer’s responsibility to procure necessary hardware to perform upgrades if required (necessary drives, such as CD-R, 
DVD-R, or ZIP).

5. Pelco cannot guarantee that all future software versions will be backward compatible with earlier hardware platforms.
C2675M-B (7/09) 11
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Installation

Getting Started
Install the Client, Emergency Agent, and Export Viewer software on your remote computer. 

RECOMMENDED SYSTEM REQUIREMENTS

MINIMUM PC REQUIREMENT
Minimum recommended system requirements for the DX4500/DX4600 Client, Emergency Agent, and Viewer software applications are as follows: 

• Operating system: Windows 2000 (SP4) or later and DirectX® 8.1 or later

• Processor: Intel® Pentium® 4

• Memory: 512 MB

• Video Card: VGA card with 64 MB Video RAM or greater

RECOMMENDED PC REQUIREMENTS
• Operating System: Windows Vista or Windows XP (SP2)

• Processor: Intel Pentium 4 (or later), 2.4 GHz

• Memory: 512 MB

• Video Card: VGA card with 128 MB Video RAM

• Remote Administration: Full remote control through TCP/IP network

INSTALLING THE CLIENT APPLICATION
1. Start the Windows operating system.

2. Close all programs, including any antivirus software.

3. Insert the DX4500/DX4600 resource disc into the remote computer CD/DVD drive, and wait for the window to open.

4. Follow the installation prompts to install the software.



Getting Acquainted

Application Window

Figure 2. Client Application Window

Site Tree: Displays top-down, hierarchical management of DX4500/DX4600 resources, such as servers, cameras, alarms, and relays.

Toolbar: Provides buttons for quick access to Live View, Search, Setup, Export, print, screen divisions and the Connection List. 

Title Bar: Displays the application title.

Menu Bar: Provides access to drop-down menus.

View Panels: Organizes the application display area in as many as 16 panes for displaying live and playback video. A view pane is a 
division of the view panel. Each view pane displays video for a single camera channel. For additional information about view panels and 
panes, refer to Navigating View Panes on page 63.

PTZ Control Panel: Allows users to operate cameras that support PTZ features. 

PTZ OSD Menu: Allows users to operate PTZ OSD features. For information on using the PTZ OSD menu controls, refer to PTZ Controls 
on page 69.
Playback Control Panel: Allows users with administrator- or power-level permission to control video playback. Includes playback 
controls, and playback speed and volume. 
Playback Timeline: Displays a 24-hour timeline marked with color-coded video events. Allows users with administrator- or power-
level permission to select a date and time for playback. 

Status Bar: Displays current date and time and the permission level of the logged on user. 
C2675M-B (7/09) 13



MENU BAR
The DX4500/DX4600 Menu bar allows you to easily access the features of the File, View, and Help menus. The following tables describe the 
commands and functions of the Menu options. 

FILE MENU

VIEW MENU

Table A.  File Menu

Command Description
Connect Opens the Remote Login dialog box for entering the user name and password.
Disconnect Immediately logs the current user off from the remote site. The Client application returns to the disconnected 

mode and Log Out is displayed in the status bar.
Save to JPEG From paused playback or the Search mode, opens the Export dialog box to save captured camera video in JPEG 

format to a designated location on the PC hard drive. The default location is C:\DX45_4600 Exported files. 
Backup Search From the playback mode, opens the Backup Search dialog box to search backed up video on a media device.
End Backup Search Ends the backup search mode.
Exit Exits the Client application to the Windows environment.

Table B.  View Menu

Command Description
OSD Opens a submenu with the following choices:

• Channel Number: A global setting that displays the input channel number to which the camera is 
connected.

• Site Name: A global setting that displays a site’s name in the respective view pane.

• Camera Name: A global setting that displays a camera’s name in the respective view pane.

• Playback Time: A global setting that displays the date and time that video was recorded when the video 
is played back.

• PTZ: A global setting that enables PTZ capability for the cameras assigned to a view pane.

• Audio Recording: A global setting that enables audio recording for the cameras assigned to a view 
pane. The DX4500/DX4600 compresses audio data to save space. In this case, recorded audio may not be 
of the same quality as live audio.

• Select All: Selects all of the OSD options.
Sequence (Dwell Time) Opens a submenu of dwell times with the following choices:

• 5 Sec.

• 10 Sec.

• 15 Sec.

• 20 Sec.
Language Opens a submenu with the following choices:

• English (default)

• Japanese

• Korean

• Chinese

• Portuguese

• Spanish

• Russian

• Turkish

• French

• German

• Polish

• Italian
14 C2675M-B (7/09)



HELP MENU

GUI TOOLBAR

HDD Information Opens the HDD Information dialog box that displays the normal and event partition storage capacity status. 
Log View Displays system events that have occurred on the date selected in the Date drop-down box.

Table C.  Help Menu

Command Description
DX4500/DX4600 Client 
Information

Provides model and version information for the DX4500/DX4600 application.

Table D.  GUI Toolbar 

Live View: Enters the display mode and opens the DX4500/DX4600 main window, where live and playback video is viewed.
• Live Mode: Allows all users to view live video.
• Playback Mode: Allows users with administrator- or power-level permission to play back recorded video. The DX4000 does 

not support playback in the Live View mode; when a camera attached to a DX4000 is selected, the controls are not available.

Search: Opens the Search window, providing access to search features. Users with administrator- or power-level permission are 
able to search video data.

Setup: Opens the Setup window of the Camera page (default view), and provides access to other pages. Users with 
administrator- or power-level permission are allowed to set up the features and options for the DVR.

Export: Opens the Export dialog box from the main application window. Users with administrator- or power-level permission are 
allowed to set up the features and options for the DVR.

Print: Opens the Print dialog box.

Single Division View: Displays video from one camera.

4 Division View: Displays video from four cameras simultaneously.

9 Division View: Displays video from nine cameras simultaneously.

16 Division View: Displays video from sixteen cameras simultaneously.

6 Division View: Displays video from six cameras simultaneously; one large pane and five smaller images.

8 Division View: Displays video from eight cameras simultaneously; one large pane and seven smaller images.

Cycle Views: Turns on and off window cycling. 

Full Screen: Displays video from one camera, expanding the application window to occupy the entire screen. Click the right 
mouse button to exit full-screen view. 

Connection List: Opens the Connection List dialog box. Use this dialog box to add, edit, and delete remote sites.

Table B.  View Menu

Command Description
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VIEW PANES AND PANELS
The DX4500/DX4600 Client viewing panel is organized into panes. Video from each camera appears in its own viewing pane. 

Figure 3. View Panes and View Panel

View Pane: A view pane is a division of a view panel. Each view pane contains a single camera channel; up to 16 view panes can fit in 
a view panel.

View Panel: A view panel is made up of the entire Client viewing area. The Client view panel can contain 1 to 16 panes and can 
connect with up to 16 remote sites. The view panel can also display video from the selected cameras in each of the remote sites. 
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SITE TREE
The site tree provides access to remote site resources (cameras and alarm inputs). Cameras are selected by clicking once with the left mouse 
button and dragging the icon on to a view pane. The site tree information reflects the current remote server configuration.

Figure 4. Site Tree

Site: Expands and collapses the remote site. Right-clicking the site name opens a shortcut menu containing the following 
commands:
• User Log-In: Opens the Remote Login dialog box to log on to the remote site.

• User Log-Out: Logs you off of the remote site.

• Connect: Opens the Remote Login dialog box to connect to and log on to the remote site

• Disconnect: Logs off from and disconnects the Client from the remote site. The Pelco logo is displayed indicating that the 
Client application is not connected to a remote site.

 Camera: Expands and collapses the Camera tree.

 Channel: Expands and collapses the channel information for the input channel.

Channel Information: Displays icons that represent the camera’s configuration.
• Recording resolution

• Recording frame rate

• Recording image quality

• Recording mode

• Relay output linked to a camera

• Audio input linked to a camera

 Alarm: Expands and collapses the Alarm tree. Expand an alarm input to see the relay out and camera assignment.
C2675M-B (7/09) 17



PTZ CONTROL TOOLBAR
The PTZ control is available for cameras that support PTZ functions using Pelco C, Pelco P, and Pelco D protocols. It is also available for supported 
third-party dome cameras. In addition, the PTZ option must be enabled and a protocol must be assigned to the camera channel. For information 
about configuring camera features, refer to Camera Setup on page 31.

Figure 5. PTZ Control Toolbar

ZOOM: Zooms the camera in and out.

FOCUS: Performs two functions:

• In PTZ mode: Adjusts the camera focus.

• In camera menu: FOCUS+ and FOCUS- is used to navigating up and down the camera menu choices.

IRIS: Performs two functions:
• In PTZ mode: Opens and closes the camera iris.
• In camera menu: IRIS+ selects an item. IRIS- exits an option setting and in the menu, moves the cursor to EXIT.

Keypad: Enters presets or pattern numbers.

Program: Accesses the camera programming mode.

Clear: Deletes a programmed preset, pattern, or tour.

PRESET: Performs three functions:
• In preset programming mode: Stores the preset in the selected memory location. 
• In PTZ mode: Activates a preset.
• Tour: Starts a a preset tour. 

PATTERN: Performs two functions:
• Pattern programming mode: Stores the pattern in the selected memory location. 
• PTZ mode: Activates a pattern.

Auxiliary: Selects the auxiliary mode. Buttons 1–4 select the camera’s auxiliary outputs. Buttons 1–4 operate as a toggle 
(on/off) each time they are selected.

SET: Performs two functions:
• Enters PTZ programming mode.
• Exits PTZ programming mode.

PGM

CLR

PRESET

PATTERN

AUX

SET
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Figure 6. PTZ OSD Menu Control

Enter: (Third-party cameras only) Provides the following actions:
• Displays the selected remote camera OSD menu for PTZ cameras.
• Accepts the selected remote camera OSD menu choice.
• Accesses menu option parameters. 

Exit: (Third-party cameras only) Exits the camera menu. 

Up and Down Arrows: 
• Moves the camera.
• Navigates through the remote camera OSD menu or cycles through a list of options or parameters.

Left and Right Arrows: Moves the camera.

��

�

�
�
�
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LIVE VIEW ON-SCREEN DISPLAY
The DX4500/DX4600’s on-screen display (OSD) consists of superimposed camera and site information. Each item in the OSD can be displayed or 
hidden. In this case, a global setting applies for all channels. Some labels are not supported by the DX4000 and do not display.

Figure 7. Live View OSD Pane

PTZ: Indicates that the PTZ control is enabled.

Audio: Indicates that audio recording is enabled. The DX4500/DX4600 compresses audio data to save space. In this case, recorded 
audio may not be of the same quality as live audio. 

Recording: Indicates camera recording mode and status. 

• No recording : The camera displays live video, but the system does not record video.

• Normal recording : The system continuously records video. 

• Instant recording : Manually starts and stops the recording of video.

• Motion recording : Records video for a channel configured for motion event recording only.

• Alarm recording : Records video for a channel configured for alarm event recording only.

On-Screen PTZ Control: Facilitates mouse control of PTZ functions. Refer to PTZ on page 69. 

Site Designator: Lists the number and name of the current site.

Camera Designator: Lists the number and name of the current camera.

N

I

M

A
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PLAYBACK CONTROLS
The playback controls start playback, control direction, and adjust speed. Click the Stop button at any time to return to Live View. 
The DX4000 does not support playback in the Live View mode; when a camera attached to a DX4000 is selected, the controls are not available. 
In the search mode, the DX4000 supports the playback, pause, stop, and play features.

PLAYBACK

Figure 8. Playback Controls

PLAYBACK SPEED AND VOLUME

Figure 9. Playback Speed and Volume Controls

Frame-By-Frame Reverse: Each frame is displayed in the reverse direction by repeatedly clicking the button.

Frame-By-Frame Forward: Each frame is displayed in the forward direction by repeatedly clicking the button.

Fast Forward to End: Advances the bookmark to the end of the latest recorded video. 

Play Forward: Initiates normal playback of recorded video in the forward direction.

Stop: Stops playback control activity and returns to the Live View mode.

Pause: Pauses video playback.

Play Reverse: Initiates normal playback of recorded video in the reverse direction.

Fast Reverse to Beginning: Returns the bookmark to the beginning of the earliest recorded video. 

Normal: Plays back video at normal speed.

Faster: Plays back video at a faster rate than normal speed.

Slower: Plays back video at a slower rate than normal speed.

Volume: Increases or decreases the volume of played back video.

Audio: Activates or silences the audio output of played back video.

� �

� �
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�
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PLAYBACK TIMELINE
The playback timeline is used to select the date and time to begin playback. Time periods containing recorded video are represented as color-
coded segments of the timeline. The timeline includes a horizontal pointer that shows the time in 1-hour segments. The pointer is positioned 
within the timeline by using the hour, minute, and seconds drop-down boxes to select playback time in 24-hour period. While in Live View mode, 
you can drag the timeline pointer into the timeline. The scroll bar allows you to position the timeline within a 24-hour period. 

Figure 10. Playback Timeline

OPERATING MODES
The DX4500/DX4600 Series DVR has four primary operating modes: Live, Playback, Search, and Setup. Each operating mode is accessed by 
clicking its corresponding button on the toolbar. 
 

Camera Number Decrease Detail

Remote Site Normal/Instant Recording

Date Motion Detection Recording

Hour Pointer 

Minute Scroll Bar

Second Alarm Recording

Increase Detail Select All (unavailable in Live mode; available for Search mode)

Table E.  Client Operating Modes

Live View: Enters the display mode and opens the DX4500/DX4600 main window, where live and playback video is displayed:
• Live Mode: Allows all users to view live video.
• Playback Mode: Allows users with administrator- or power-level permission to play back recorded video. The DX4000 does not 

support playback in the Live View mode; when a camera attached to a DX4000 is selected, the controls are not available.

Search: Opens the Search, providing access to search features. Allows users with administrator- or power-level permission to 
search video data using specific criteria. The DX4000 supports the date/time search feature. 

Setup: Opens the Setup window of the Camera page (default view), and provides access to the other setup pages. Users with 
administrator-level permission are allowed to set up the features and options for the DVR. 
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Client Application
Logging on to DVR servers using the Client application requires the following: 

• Starting the Client application

• Ensuring the DVR servers are available in the Client application site tree, or adding the DVR server to the site tree using the Connection List 
dialog box

• Connecting to and logging on to the DVR server

The Client application has the following conditions:

• Client application startup password: The password for starting the DX4500/DX4600 application is “000000” (six zeros). This password 
cannot be changed. The default password for the DX4000 is “1234.”

• No DVR servers are displayed in the site tree: If the Client application window opens in the 16 division view and no DVR servers are 
listed in the Connection List dialog box, the Pelco logo is displayed in each pane, the Client application menu items and controls are 
available, and Log Out is displayed in the status bar.

• One or more DVR servers are listed in the site tree: If the Client application window opens in the 16 division view and the servers 
displayed in the site tree are listed in the Connection List dialog box, live video from the first server in the site tree is displayed in the Client 
application window, and the Client application menu items and controls are available. 

• Connection List setup: Each DVR server must be listed in the connection list before the Client application can connect to the server. 

• Server capacity: The Client application can connect with as many as sixteen DX4500/DX4600 and DX4000 servers. One DX4500/DX4600 
server can accommodate up to five remote connections (for example, three remote Client connections and two Web Client connections, or 
any combination of the two). For information about the number of connections the DX4000 server can host, refer to the DX4000 Operation 
manual.

• DVR server default user name and password: 
– Both the default user name and password for the DX4500/DX4600 DVR server are admin. The default user name for the DX4000 DVR

is Administrator. The default Administrator password is “1234.”
– When logging on to a DVR server, you must have a user name and password registered on that DVR server. 
– If the DVR server is installed by another person, the default password might already be changed. In this case, contact your system

administrator to obtain a user name and password.
– If you are configuring the server and Client application for the first time, Pelco recommends that you change the default administrator

password. The admin (DX4500/DX4600) and Administrator (DX4000) user names cannot be changed. For information about changing
the password, refer to Changing the Administrator User Password on page 58.

STARTING THE CLIENT APPLICATION
When the Client application is started for the first time, no remote sites are displayed in the site tree and the Pelco logo is displayed in the 
application window. By default, the Client application window opens in the 16 division view. 

If no remote sites are displayed, the first step is to add them to the site tree. For information about adding remote sites to the site tree, refer to 
Adding Remote Sites on page 98.

The following steps assume that remote sites are displayed in the site tree.

1. On the task bar, click Start > All Programs > Pelco > PELCO Network Client > DX4500_DX4600 Client. The Client Password dialog box opens. 

Figure 11. Client Password Dialog Box

2. In the Password text box, click the box and type the default Client password 000000 (six zeros). 

3. Click OK. The DX4500_DX4600 Client application window appears and the Connection List dialog box opens. At this point, the Client 
application is not connected to a DVR site. You must connect to a DVR site to view video. In the process of connecting to a remote site, you 
are logged on to the site.
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Figure 12. Application Window and Connection List

CONNECTING TO AND LOGGING ON TO A REMOTE SITE
After the Client application starts, logging on to a remote site involves two steps: connecting to the site and then logging on to the DVR server.

1. To connect to and log on to a remote DVR server site, in the site tree, click a remote site. The remote site is highlighted. 

2. Do one of the following:
• DX4500/DX4600:

(1) From the DX4500_DX4600 menu bar, click File > Connect or in the site tree, right-click a remote site. The Remote Login dialog 
box opens. The name of the remote site is displayed in the site Name box.

Figure 13. Remote Login Dialog Box

(2) Click the User ID text box, and then type your assigned remote site user name.

(3) Click the Password text box, and then type your assigned password.

(4) Click OK. The system logs you on to the remote site and your user level appears in the status bar. No video is initially displayed 
from the remote site because cameras are not yet assigned to view panes.

• DX4000: 

NOTE: You can connect to only one DX4000 at a time. 

(1) From the DX4500_DX4600 menu bar, click File > Connect. In the site tree, right-click a remote site, and then click Connect. 
The DX4000 icon changes color, indicating that the remote client is connected to the server.

3. To display live video from the remote site:
a. In the site tree, click the remote site to expand the tree.

b. Click and drag the Cameras icon on to the view panel. The cameras are sequentially assigned to view panes.

LOGGING OFF FROM A REMOTE SITE
The DX4500/DX4600 allows you to log off from a remote site without disconnecting from the site. In this case, the user has guest-level 
permission. At the guest level, you can still view live video from the site in the Client application window and are allowed limited use of the 
Client application features and controls. To log off from the DX4000, you must disconnect from the remote site.

To log off from a DX4500/DX4600 remote site:

1. In the site tree, right-click a remote site. The site tree submenu appears.
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Figure 14. Logging Off from a DX4500/DX4600 Remote Site

2. Click User Log-Out. The system logs you off and Guest is displayed in the status bar.

To disconnect from a DX4000 remote site:

1. In the site tree, right-click a remote site. The site tree submenu appears.

Figure 15. Logging Off from a DX4000 Remote Site

2. Click Disconnect. The remote client disconnects from the remote server and the user status changes to Log Out.

AUTOMATICALLY CONNECTING TO A REMOTE SITE
1. On the task bar, click Start > All Programs > Pelco > PELCO Network Client > DX4500_DX4600 Client. The DX4500_DX4600 Client Password 

dialog box opens. 

2. In the DX4500_DX4600 Client Password dialog box, do the following:
a. Click the Password text box, and then type the default Client password 000000 (six zeros). 

b. Click the Auto Connect check box to select automatic connection to the remote site. Perform this step each time you start the Client 
application.

Figure 16. Selecting Auto Connect

3. Click OK. The Client application window appears, a connection is made to the first remote site in the site tree, and video from that site is 
displayed.
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DISCONNECTING FROM A SERVER
1. In the site tree, right-click a remote site. The site tree submenu appears.

Figure 17. Disconnecting from a DVR Server

2. Click Disconnect. The Client application is disconnected from the remote site, the Pelco logo appears, and Log Out is displayed in the status 
bar. To reconnect to the remote site, you must log on to the remote site again.

EXITING THE CLIENT APPLICATION
1. To exit the Client application:

• Click File > Exit.
• In the application window, click the Close button .

The Client application exits to the Windows environment.
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DX4500/DX4600 Export Viewer
GETTING STARTED

Welcome to the DX4500/DX4600 Export Viewer application. The Export Viewer allows you to play back video that is exported from the DX4500/
DX4600 server. The Export Viewer will verify the digital watermark embedded in DX4500/DX4600 native video. Watermarking is used to 
authenticate the originality of a video file and to alert users to possible image tampering. The Export Viewer application runs automatically each 
time a CD or DVD created by the DX4500/DX4600’s export feature is inserted into a Windows-based PC. The software can also be installed on a 
PC and opened independently, when necessary.

The USB mouse is used to access Export Viewer GUI controls and features. Menu commands can be selected with the mouse, or you can press 
Alt + C to select the command.

NOTE: When video recorded on the DX4500/DX4600 server located in one time zone (for example, GMT -8:00) is exported and played back on a 
computer located in a different time zone (for example, GMT -5:00), the video's original recording time is adjusted to and displayed based on the 
time zone of the playback computer. 

To play back exported video so that its original recording time is displayed correctly, the time zone setting of the playback computer must be 
identically configured to the time zone of the DX4500/DX4600 server on which the video was recorded.

STARTING THE EXPORT VIEWER
To start the Export Viewer:

1. On the tasteable, click Start > All Programs > Pelco > PELCO Network Client > DX4500_DX4600 Export Viewer. The DX4500_DX4600 Export 
Viewer application window opens. 

Figure 18. Export Viewer Application Window

Watermark Option Section Playback Slider

Playback Controls Section
 Play
 Stop
 Fast Forward to End

 Pause
 Fast Reverse to Beginning

View Panel

Menu Bar

Video Information Section
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CHANGING THE LANGUAGE
To change the language, from the menu bar, click Lang (L), and then select a language. The Export Viewer GUI changes to the selected language.

EXITING THE EXPORT VIEWER
To exit the Export Viewer application, from the menu bar, click File > Exit.

EXPORTED VIDEO FILE NAMING CONVENTION
The DX4500/DX4600 exported video file name contains details about the exported video. 

Figure 19. Exported Video File Naming Convention 

Channel/Camera Number

Date of Recorded Video

Time of Recorded Video

Pelco-Engineered Video Format
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VIEWING EXPORTED VIDEO
The DX4500/DX4600 exports video to CD/DVD and USB drives. 

To open a file for viewing: 

1. Do one of the following:

• For a USB drive: 
(1) Insert the USB drive into the computer.

(2) On the task bar, click Start > All Programs > Pelco > PELCO Network Client > DX4500_DX4600 Export Viewer. 

The DX4500_DX4600 Export Viewer application window opens. 

• For a CD/DVD drive:
(1) Insert the CD/DVD. The Export Viewer application starts automatically.

2. From the Export Viewer menu bar, click File > Open. The Open dialog box appears.

Figure 20. Open Dialog Box

3. Click the “Look in” drop-down box to select the drive and folder location of the DX4500/DX4600 exported video file(s). 

4. Select the file you want to view.

5. Click Open. The file opens in the DX4500/DX4600 Viewer window in the play mode.

6. Use the controls to playback the video. Click and drag the playback slider to scroll through recorded video in the forward or reverse direction.

VERIFYING THE WATERMARK
Watermarking is used to authenticate the originality of a video file and to alert users to possible image tampering. The Export Viewer will display 
a message if the video image has been altered.

Figure 21. Altered Video Message

To verify the watermark:

1. In the Option section, click the “Set watermark” check box. 

2. Open the exported file for which you want to verify the watermark. Playback starts. The Export Viewer performs a check to authenticate the 
watermark. If the watermark is authentic, no action is taken. If the video image has been altered, the Export Viewer displays the INFO 
dialog box.
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Set Up

Setup Window
The Client application Setup window allows you to configure and administer the DX4500/DX4600 and DX4000 from a remote location. Only users 
with administrator-level permission can access the Setup window and configure the DVR, and only a single administrator user can log on to the 
DX4500/DX4600 or DX4000 at one time. If two administrator-level users attempt to enter the Setup window simultaneously, the DX4500/DX4600 
and DX4000 will allow access on a first come, first served basis. Figure 22 shows the DX4500/DX4600 Setup window and Figure 23 on page 30 
shows the DX4000 Settings window. 

NOTE: For information about using the DX4000 Settings window to configure the unit, refer to the DX4000 Operation manual.

Figure 22. DX4500/DX4600 Setup Window and Default Camera Page

Figure 23. DX4000 Settings Window
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Camera Setup
1. To display the Camera page, do one of the following:

• On the toolbar, click the Setup button . The Setup window opens to the Camera page.

• If the Setup window is already open, click the Camera page button . The Camera page opens.

Figure 24. Camera Page Options

2. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.
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CONFIGURING CAMERAS
The Camera page allows you to configure camera properties for each camera connected to the DVR. Depending on your system’s current 
configuration, up to 16 cameras can be connected to a single DX4500/DX4600. 

• Channel: The channel refers to the actual BNC input connector. The camera designation refers to the camera device being configured.
– The DX4508/DX4608 provides BNC inputs 1–8, corresponding to Camera 01 to Camera 08. 
– The DX4516/DX4616 provides BNC inputs 1–16, corresponding to Camera 01 to Camera 16.

• Covert: Configures a camera to be viewed and operated by users logged on with administrator-level permission. In the covert mode, if a 
user is logged on with power- or normal-level permission, the Video Loss message appears. 

• Camera Disable: Enables or disables the display of video. 
– Camera not connected: If the Camera Disable box is not selected and a camera is not connected to the BNC input, the DVR displays

Video Loss in the camera pane. In this case, the DVR records the message as video data. If the channel is disabled, the DVR displays
the Pelco logo in the camera pane. In this case, the DVR does not record the video. To conserve hard drive space, Pelco recommends
that you disable all channel inputs that are not being actively used to record video.

– Camera connected: If the Camera Disable box is not selected and a camera is connected to the BNC input, video input from the
camera is disrupted and Video Loss appears in the camera pane. In this case, the Video Loss message is recorded. 

• Channel Name: Allows you to create a unique name for each camera. The Channel Name has the following guidelines:
– Characters: A to Z, a to z, numerals 0 to 9, and special characters. Spaces are not allowed.
– Name length: Up to 12 characters.

• DX4500/DX4600 Audio: Associates the audio input (1–4 [DX4516/DX4616] or 1–2 [DX4508/DX4608]) with a specified camera input. An 
audio input can be assigned to multiple cameras.

• DX4000 Audio: Associates the audio input (1–4) with a specified camera input. An audio input can be assigned to multiple cameras.

NOTE: The DX4500/DX4600 does not receive audio from the DX4000. 

Configure the following settings for Live Audio:

– Live Audio: Select On or Off. When set to On, the remote agent (DX4000) can receive live audio from a camera through the DX4000.
– Monitoring Channel: Select the audio channel that is connected to the camera. Refer to the back panel of the unit to verify the

channel number.
– Audio Network: Select the type of audio the remote agent can receive: one-way or two-way. With one-way audio, you can listen to

the audio associated with a camera. With two-way audio, the remote agent can send audio to a speaker that is connected through the
DX4000. For example, you might use this feature to allow an operator at a remote computer to communicate with a person waiting at
a locked door. Audio transmitted from the remote agent is not recorded.

For more information about configuring the DX4000 audio feature, refer to the DX4000 Operation manual.

1. In the Camera page, select a camera from the Channel drop-down box. 

2. To configure the Convert and Camera Disable settings:

c. Click the Covert check box to conceal video from users logged on with normal-level permission. 

d. Click the Camera Disable check box to select the feature to disable the channel input for all channels not actively being used to 
monitor and record video. If a camera is connected to the disabled channel, video from that camera is not displayed or recorded. 

3. To type an optional new name for the camera:
a. Click the Channel Name text box to highlight the current entry. 

b. Type the new name.

4. To assign an audio input to a camera, click the Audio drop-down box. Then click an audio input.

5. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.
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PTZ COMMUNICATION
PTZ devices are connected to the DX4500/DX4600 using the DATA 1 and DATA 2 RS-422/RS-485 ports located on the back of the unit. 
The DX4508/DX4608 supports up to eight serial PTZ cameras; the DX4516/DX4616 supports up to sixteen serial PTZ cameras. Multiple PTZ 
cameras are connected by daisy-chaining the camera connections. The DX4500/DX4600 allows you to address and control multiple PTZ cameras 
individually.

DX4500/DX4600 PTZ camera control is achieved by using the respective protocol for that camera. Table F lists the supported third-party devices 
and the protocol used by each device to operate the pan/tilt/zoom, focus, iris, and preset features.

Before you perform the PTZ setup procedure, you will need the following information for each PTZ camera being configured:

• DX4500/DX4600:
– Data port to which the camera is connected
– Camera address
– Camera protocol
– Communication settings: Baud rate, parity, data bits, and stop bits

• DX4000: 
– Camera address
– Camera protocol (Pelco P or Pelco D)
– Communication settings: baud rate

For information about connecting PTZ devices to the unit, refer to the DX4000 Installation manual. For information about configuring the 
PTZ settings, refer to the DX4000 Operation manual. 

To configure the DX4500/DX4600 PTZ communication settings, do the following:

1. In the PTZ option section, click the Port drop-down box and select the port.

2. Click the Address drop-down box to select the camera protocol address.

3. Click the Protocol drop-down box to select the protocol.

4. Click the Baud Rate drop-down box to select the camera’s baud rate.

5. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.

Table F.  DX4500/DX4600 Third-Party PTZ Compatibility 

Third-Party PTZ Device Protocol

Bosch® AutoDome® Day/Night Bosch_AutoDome

Samsung™ SCC 641 Samsung_SCC

LG™ LPT-SD163HM LG_SD168

Baxall™ BPD1-RAS916 Pelco P

American Dynamics™ Speed Dome Ultra Vll Pelco P
C2675M-B (7/09) 33



Figure 25. PTZ Communication Settings

CONFIGURING MOTION
The motion detection window allows you to see the entire motion detection area. You can define one or more motion detection areas in the 
window and areas can be defined for each camera. When the DX4500/DX4600 is set to record motion events, any motion detected in the 
selected area is recorded on that camera channel. A detected motion event can also be used to trigger a relay output.

For information about configuring the motion settings, refer to the DX4000 Operation manual.

1. In the Motion pane, left-click the mouse and drag the pointer to define the area in which you want to detect a motion event. 

Figure 26. Motion Settings
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2. Define the motion detection area.
a. You can hide or show the grid. By default, the grid is displayed. To hide the grid, click the Show Grid check box to deselect the box and 

hide the grid.

b. Click Clear All to remove the currently defined motion detection area. By default, the entire motion detection window is selected for 
motion detection.

c. Click Set All to enable motion detection for the entire viewable area.

d. Hold down and drag the left mouse button to select an area.

e. Hold down and drag the right mouse button to deselect an area.

3. To set the motion sensitivity, left-click and drag the Sensitivity slider. Moving the slider to the left decreases the sensitivity; moving the 
slider to the right increases the sensitivity. 
• High sensitivity setting: A high motion level is needed before the DVR can detect motion and record the event. In this case, an

important motion event might be missed.
• Low sensitivity setting: A low motion level will cause the DVR to detect and record video. In this case, many unwanted events are

recorded.
• Medium 50% sensitivity setting (default): A typical motion level will cause the DVR to detect and record video. Experiment with

similar motion events to adjust the sensitivity level for your application. 

4. To link a motion event to a relay output, click the Relay Output drop-down box and select a relay output.

5. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.

DISPLAY CHARACTERISTICS
The Client application allows you to configure the display settings for both the DX4500/DX4600 server and Client application. The Display 
section contains the following:

• Language: A global setting that affects the display language for the server and Client application. The Client application must be 
restarted for the new language to take effect. The server does not have to be restarted.

NOTE: Although the Client application can be configured to display information in a different language, the DX4004 only displays 
information in English. 

• Channel Name and Channel Status: Global settings that show or hide the channel name and status indicators.

• Main Monitor Dwell Time: A global setting. 

• Spot Monitor Dwell Time: Global settings. 

1. Configure the OSD feature.

a. To configure the language:

• Click the Language drop-down box and then select a language. 

• From the menu bar, click View > Language, and select a language.

b. To hide the channel name, click the Channel Name check box to deselect the setting. (By default, the channel name is displayed.)

c. To hide the channel status indicator(s), click the Channel Status check box to deselect the setting. By default, the channel status 
indicators are displayed.

2. To configure the DX4500/DX4600 main monitor dwell time, click the Dwell Time drop-down box and select a dwell time.
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3. Configure the DX4500/DX4600 spot monitor.
a. To configure the dwell time, click the Dwell Time drop-down box and select a dwell time.

b. To configure the event popup feature, click the Event Popup drop-down box and select an entry.

c. To configure the covert feature, click the Covert Camera check box. If selected, video from the camera will not be displayed on the 
spot monitor. 

Figure 27. Display Settings

4. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.
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Schedule Setup
NOTE: The DX4500/DX4600 has unique MPEG-4 recording characteristics. Images recorded at frame rates less than 7 ips when viewed using 
the DX4500/DX4600 Client Application software, might not be evenly distributed over a 1-second interval.

• DX4500/DX4600: The Client application provides extensive recording and scheduling capabilities. Flexible recording schedules can be 
established for daily, weekday, weekend, or holiday recording. Recording time is allocated in increments of 1 hour, and each increment can 
be scheduled to record continuously or in response to an alarm or motion event. 

• DX4000: The Client application provides extensive recording and scheduling capabilities. Timer recording schedules can be established for 
daily or weekly recording. For more information about configuring the recording mode, refer to the DX4000 Operation manual.

1. In the DX4500/DX4600 Setup window, click the Schedule page button . The Schedule page opens. 

Figure 28. Schedule Page Options

SCHEDULES
The Client application provides a flexible scheduling feature that allows you to create daily, weekly, and holiday schedules. The DX4600 allows 
you to schedule each camera to record in a single or multi-event (overlapping) mode across a 24-hour timeline. You can also configure each 
camera to record at a specific resolution, quality, and image rate when an event is triggered. 

Recording schedules are easily created for each channel and changed without affecting the schedule of other channels. Up to 10 different 
holiday schedules can be created. If a holiday schedule occurs on the same date as a weekday schedule, the holiday schedule will override the 
weekday schedule. You can also initiate the manual record mode, which takes precedence over the current recording schedule. The 
DX4500/DX4600 supports copying schedules between channels, days, weekdays, and weekends. 

The Client application supports the following scheduling modes:

• DX4500/DX4600: 
– No record (white): The DVR is displayed, but does not record video. 
– Normal (green): The DVR records video data continuously over a 24-hour period. This mode uses the most hard disk storage.
– Alarm (red): The DVR only records video if an alarm event is detected.
– Motion (blue): The DVR only records video if a motion event is detected.
– Alarm and motion (yellow): By default, the DVR records video data if either an alarm or motion event is detected.
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• Multi-event recording: Only the DX4600 supports multi-event recording. 
– Alarm or motion (yellow): The DVR only records video data if either an alarm or motion event is detected.
– Normal or Alarm (green and red): The DVR records normal video data until an alarm event is detected and then changes to 

recording alarm video data.
– Normal or motion (green and blue): The DVR records normal video data until a motion event is detected and then changes to 

recording motion video data.
– Normal, alarm, or motion (green and yellow): The DVR records normal video data until an alarm or motion event is detected and 

then changes to recording video for the detected event. 

• DX4000: For information about the scheduling feature, refer to the DX4000 Operation manual.

The Client application allows you to schedule a camera for multi-event recording. The pre-event image rate is the same image rate as the current 
recording mode prior to the beginning of an event (instant, alarm, or motion record). Instant recording has the highest priority of the record 
modes.

For example, the DVR is recording at 1 ips in the Normal mode. When an event occurs, video is recorded at 1 ips during the pre-event time period. 
After the pre-event time period expires, the image rate changes to the pre-configured event image rate until the post-event time period expires. 
After the post-event time period expires, the image rate changes back to the Normal mode image rate. 
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DAILY RECORDING SCHEDULE
1. In the Schedule page, click a day of the week.

2. To schedule a camera recording mode:
a. Select one or a combination of two recording mode check boxes to select a recording mode (No Record, Normal, Alarm, Motion, 

Motion+Alarm). 

For example, to set CAM 01 for Normal/Motion/Alarm multi-event recording, click the check box for Normal and Motion+Alarm. (refer 
to Figure 28).

b. In the row of the selected camera, left-click and drag the range of time (1–24 hours) you want to schedule. The cells in the row 
change color. 

Figure 29. Select a Recording Mode

3. To schedule additional recording modes for the same or different camera, repeat step 2.

4. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.
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COPYING SCHEDULES
The Client application allows you to copy a schedule from one day of the week to any of the following:

• Weekday (M–F): The schedule from the selected day is copied to the respective channels for every day of the week, except Saturday and 
Sunday.

• Weekend (Saturday and Sunday): The schedule from the selected day is copied only to the respective channels for Saturday and 
Sunday. The schedule is not copied to the weekdays (Monday–Friday). 

• Day (Sun–Sat): The schedule from the selected day is copied to the respective channels of the destination day.

NOTE: DX4500/DX4600 server supports copying schedules between channels. The Client application allows you to view schedules created 
using this feature, but does not support copying between channels. 

1. In the Schedule Copy section, click the From drop-down box, and then select a day. The selected day’s schedule appears.

Figure 30. Copying a Schedule

2. Click the To drop-down box, and then select a schedule period. 

3. Click OK. The system copies the schedule.

4. Click the period to which the schedule is copied to verify that the destination schedule is identical to the source schedule.

5. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.
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HOLIDAY SCHEDULES
The Client application allows you to create up to 10 holiday/custom schedules. If a holiday schedule occurs on the same date as a weekday 
schedule, the holiday schedule will override the weekday schedule. 

Creating a Holiday Schedule
1. In the Holiday section, click the Holiday check box to select the holiday scheduling mode. The Holiday Schedule grid and scheduling controls 

are displayed. By default, the holiday schedule is set to No Record. If at least one holiday schedule exists, it is displayed in the grid.

Figure 31. Holiday Schedule

2. In the Holiday calendar, select a date for the holiday schedule. 

Figure 32. Holiday Calendar
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3. To assign a name to the holiday schedule:
a. Click in the Name text box and type a name.

b. Click Add.

Figure 33. Holiday List

4. To schedule a camera recording mode:
a. Click a recording mode check box to select a recording mode. 

b. In the row of the selected camera, left-click and drag the range of time (1–24 hours) you want to schedule. The cells in the row change 
color. 

c. Repeat steps 4a and 4b to schedule multiple recording modes and cameras.

Figure 34. Scheduling Holiday Recording

5. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.
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Adding a Special Day Schedule
The Client application allows you to quickly create a custom schedule. In this case, the system assigns the name Specialday-20070710, which is 
determined by the date selected in the holiday calendar.

1. In the Holiday section, click the Holiday check box to select the holiday scheduling mode. 

2. In the Holiday calendar, select a date.

3. In the Holiday list, click Add. The system adds a new schedule to the list.

Figure 35. Creating a Special Day Schedule

4. To schedule a camera recording mode:
a. Click a recording mode check box to select a recording mode. 

b. In the row of the selected camera, left-click and drag the range of time (1–24 hours) you want to schedule. The cells in the row 
change color. 

c. Repeat step 4a and 4b to schedule multiple recording modes and cameras.

5. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.
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Deleting and Recovering Holiday or Special Day Schedules

To delete a holiday or special day schedule:

1. In the Holiday section, click the Holiday check box to select the holiday scheduling mode. 

2. In the Holiday list, click a schedule.

3. Click Delete. The selected schedule is deleted from the list.

4. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.

To recover a deleted schedule:

1. On the DX4500/DX4600 toolbar, click the Setup button . The “Configuration data has been changed. Save?” dialog box opens. 

2. Click Cancel and exit the Setup window. In this case, the changes are not saved. 

3. On the DX4500/DX4600 toolbar, click the Setup button . The Setup window appears.

4. Click the Schedule page button . The Schedule page opens and the schedule appears in the list.

WARNING: If you have not saved the changes after deleting a holiday or special day schedule, the deleted schedule can be recovered. 
If the changes are saved after deleting a schedule, the schedule cannot be recovered.
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CONFIGURING CHANNEL IMAGE RATE SETTINGS
The Client application can record up to 480 images per second (ips) by National Television System Committee (NTSC) standards and 400 ips by 
Phase Alternating Line (PAL) standards. The total frame rate capacity is distributed among 8 or 16 cameras, depending on the configuration of 
your unit. Resolution and frame rate values can be assigned evenly among all cameras or they can be configured independently for individual 
cameras. For information about the channel image rate feature, refer to the DX4000 Operation manual.

NOTE: The record mode settings (Resolution, Quality, Image Rate, Prealarm, and Postalarm) cannot be customized according to schedules. The 
record mode settings apply during the Normal record mode; however, multi-event recording allows you to configure the resolution, quality, and 
image rate specifically for each event (instant, alarm, and motion record). The multi-event recording settings cannot be customized according to 
schedules.

All cameras are optimized to provide 30 ips frame rates at 320 x 240 (NTSC)/ 352 x 288 (PAL) resolution. The Client application allows you to 
change the frame rates available to each camera while resolution values remain constant, or you can change both frame rate and resolution 
settings. 

The Client application allows you to configure the following record settings for each camera: 

• Resolution: By default, the resolution is set to 352 x 240.

• Quality of recording picture: Lowest, low, standard, high, and highest. Image quality is a function of video compression. Higher quality 
video images require larger file sizes. The default quality setting is standard.

• Pre-alarm recording time: OFF, 5, 10, 20, 30, 40, 50, and 60 seconds. This setting specifies the amount of time the DVR stores recorded 
video prior to the beginning of an alarm or motion event. The default pre-alarm recording time is OFF. 

• Post-alarm recording time: OFF, 10, 20, 30, 40, or 50 seconds or 1, 2, 3, 5, or 10 minutes. This setting specifies the amount of time the 
DVR continues to record video after the alarm or motion event ends. The default post-alarm time is 10 seconds.

CONFIGURING RECORD SETTINGS

To set the record values for each channel/camera for Normal record mode: 

1. In the Schedule page, click the Record Settings button. The Image Rate Settings dialog box opens. 

Figure 36. Record Settings

Resolution DX4608/DX4616 IPS Settings DX4508/DX4516 IPS Settings
NTSC 352 x 240 1, 3, 5, 7.5, 15, 20, 30 1, 3, 5, 7.5, 15

704 x 240 1, 3, 5, 7.5, 15 1, 3, 5, 7.5
704 x 480 1, 3, 5, 7.5 1, 3

PAL 352 x 288 1, 3, 5, 6, 12.5, 20, 25 1, 3, 5, 6, 12.5
704 x 288 1, 3, 5, 6, 12.5 1, 3, 5
704 x 576 1, 3, 5, 6 1, 3
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2. For each required channel/camera, do the following:
a. To set the resolution, click the drop-down box, and then select a setting. 

b. To set the quality, click the drop-down box, and then select a setting. 

c. To set the image rate, click the drop-down box, and then select a setting. 

d. To set the pre-alarm recording time, click the drop-down box, and then select a setting. 

e. To set the post-alarm recording time, click the drop-down box, and then select a setting. 

NOTE: The illustration in Figure 37 shows the default values for each setting. In the Client application, only one Image Rate settings 
dialog box can be clicked at a time.

Figure 37. Default Record Settings

3. Click OK. The Image Rate settings dialog box closes.

4. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.
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CONFIGURING MULTI-EVENT RECORD SETTINGS
To configure the alarm, motion, and instant record settings, respectively:

1. In the Schedule page, click the Alarm Record button. The Alarm Record dialog box opens. 

Figure 38. Alarm Record Settings

2. For each required channel/camera, do the following:
a. To set the resolution, click the drop-down box, and then select a setting. 

b. To set the quality, click the drop-down box, and then select a setting. 

c. To set the image rate, click the drop-down box, and then select a setting. 

3. Click OK. The Alarm Record settings dialog box closes.

4. Do one of the following:
• To configure the settings for another event, repeat steps 1 to 3.
• To complete configuring the multi-event recording settings, go to step 5.

5. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

• Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will 
not be saved.
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Linking Setup
ALARM INPUTS

The Client application allows you to link an alarm input to a camera, and then link a camera to a relay output. The Client application supports up 
to eight alarm inputs and up to four relay outputs. The DX4516/DX4616 supports up to 16 alarm inputs and up to four relay outputs. For 
information about configuring the alarm inputs, refer to the DX4000 Operation manual.

An external AC power outage can impact how the DX4500/DX4600 relay and alarm features function.

• Power outage: Relays configured as N.O. are closed if the DX4500/DX4600 server is shut down by a power outage or if the AC cord is 
unplugged. 

• Power button: Relays configured as N.O. are closed if the DX4500/DX4600 power button is pressed and held down. 

In the scenarios above, a relay will remain closed as long as the DX4500/DX4600 is without power. In this case, alarms or sirens connected to the 
relays might produce a false alert. Most applications will not require you to change relay and alarm settings from their default states.

1. In the Setup window, click the Linking page button . The Linking page opens. 

Figure 39. Linking Page Options

2. To link an alarm input (01–16 or 01–08), do the following:
a. Click the Input Type drop-down box and select a setting. 

b. Click the Camera drop-down box and select a camera. 

c. Click the Relay Output drop-down box and select a setting. 

3. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.
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Network Setup
The Client application allows you to configure certain network settings. You can view the network settings, but you cannot administer them from 
the Client application. Those settings that are unavailable must be configured on the DX4500/DX4600 server. For information about configuring 
network settings, refer to the DX4500/DX4600 Operation/Configuration manual or the DX4000 Operation manual.

1. In the Setup window, click the Network page button . The Network page opens. 

Figure 40. Network Page Options

Table G.  TCP/IP Ports Used by the DX4500/DX4600 and Client Application

Port Number User Configurable Description
9002 Yes Base port for transmission of video, audio, and interface data
9003 Yes Software upgrades
9004 Yes Emergency agent notifications
9005 No Information port 
13900 No Ping port
C2675M-B (7/09) 49



TCP/IP
You can view the TCP/IP network settings, but you cannot administer them from the Client application. Bandwidth throttle is the only setting you 
can configure.

1. In the TCP/IP section, click the Bandwidth Throttle drop-down box, and then select a setting. 

Figure 41. Bandwidth Throttle Settings

2. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.

DDNS
The DX4500/DX4600 Dynamic DNS (DDNS) feature uses the services provided by No-IP™. Prior registration with No-IP is required before 
configuring the system to use DDNS. 

The DDNS feature uses port 8245 provided by No-IP (www.no-ip.com). If the DVR is installed in a network with a firewall, port 8245 has to be 
opened to allow DDNS data to penetrate. For information about setting up the firewall, contact your network administrator or network service 
provider.

1. In the DDNS section, click in the User ID text box, and then type the assigned DDNS user name. 

Figure 42. DDNS Settings

2. Click in the Password text box, and then type the assigned DDNS password.

3. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.
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NOTIFICATION
The Client application allows you to configure an event for notification. The notification will be sent to a designated e-mail address or to the 
DX4500/DX4600 Emergency Agent. In this case, the Mail and Emergency options must be configured. 

NOTE: The DX4000 does not support a notification feature.

The notification feature supports the following events:

• Alarm: By default, the recording mode is motion and alarm. However, the system must be configured to receive an alarm input from an 
external source. The system’s recording mode is already configured to detect an alarm event.

• Motion: By default, the recording mode is motion and alarm. The system’s recording mode is already configured to detect motion event.

• Disk full: The disk full feature contains the following:
– Overwrite property set to ALL: By default, the hard disk overwrite setting is ALL. When the hard drive is full (the normal and event

partitions are full), the system continues to record video by writing over previously recorded data (oldest recorded data is overwritten
first). In this case, the system will not send a notification message even though the hard drive is full. 

– Overwrite property set to OFF: When the hard drive is full (normal, event partition, or both), the system stops recording. In this case,
the system will send a notification message. 

– Overwrite property set to NORMAL: When the normal partition is full, the system continues to record by writing over previously
record data in the normal partition. When the event partition is full, the system stops recording data to the event partition. In this case,
the system will send a notification message.

– Overwrite property set to EVENT: When the event partition is full, the system continues to record by writing over previously record
data in the event partition. When the normal partition is full, the system stops recording data to the normal partition. In this case, the
system will send a notification message.

• Admin password changed: The system issues a notification if the administrator password is changed. Changing the password of 
additional users assigned administrator-level permission will not initiate a notification message.

• Video loss: The system issues a notification message if video loss is detected on the input channel. 

• Power on/off: The system issues a notification message if power to the DVR is not correctly turned off. 

MAIL
The DX4500/DX4600 mail feature sends an e-mail notification to all designated users if an event is detected. For example, an alarm or motion 
event is detected or the administrator password is changed. For information about configuring notification, refer to Notification on page 51. 

NOTE: The DX4000 does not support this feature.

The mail feature is configured and operates independently from the emergency agent feature. When configured, the emergency agent feature 
sends an emergency report to the designated computer on which the Emergency Agent application is installed. For information about setting up 
the emergency notification feature, refer to Emergency Notification on page 53.

To use emergency e-mail notification, the DX4500/DX4600 Series DVR must be connected to a local area network (LAN) that maintains an SMTP 
mail server. The network must also be connected to either an intranet or the Internet depending on the location of the e-mail accounts to which 
you want to send notification. Consult your network administrator for information on configuring e-mail notification on your local network. 
DX4500/DX4600 does not support Google Gmail.

The mail feature contains the following:

• Notification: Turns on and off the notification feature.

• SMTP Server: The SMTP server IP address or host name. Supports up to 24 characters including 0.0.0.0–255.255.255.255, a–z, A–Z, 
numerals 0 to 9, and special characters.

• SMTP Port No.: The SMTP port. The default TCP/IP port used for SMTP is 25. Supported values are 25 and 1025–65535.

• User Name: The name of user to be notified. Supports up to 24 characters including 0.0.0.0–255.255.255.255, a–z, A–Z, numerals 0 to 9, 
and special characters.

• Password: The user password. Supports up to 24 characters including a–z, A–Z, numerals 0 to 9, and special characters.

• Mail Address (1–4): The user’s e-mail address. Supports up to 24 characters including a–z, A–Z, numerals 0 to 9, and special characters.

• E-mail Test: Sends a test message to verify that the SMTP server can be reached. 

NOTE: This function does not verify that the user has received the e-mail message.
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The SMTP server IP address, port number, user name, and password are optional settings. The DVR can send e-mail without using an SMTP 
server or MTA (message transfer agent). In certain cases, e-mail should be forwarded to a SMTP server.

1. In the Mail section, click the Notification check box to enable e-mail notification. 

2. To configure the SMTP settings:
a. Click in the SMTP Server text box, and then type the server IP address or host name.

b. (Optional) Click in the SMTP Port No. text box, and then type the port number.

c. Click in the User Name text box, and then type the user’s name.

d. Click in the Password text box, and then type the user’s password.

e. Click in the Mail Address1 text box, and then type the destination e-mail address.

f. Repeat step 2e to enter up to two additional e-mail addresses.

Figure 43. Mail Settings

3. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.
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EMERGENCY NOTIFICATION
The DX4500/DX4600 Emergency Notification feature sends an emergency report to the designated computer on which the Emergency Agent 
application is installed. For example, if an event is detected or the administrator password is changed, a message appears on the remote 
computer’s monitor. The message provides information about the specific event, provided the event was enabled using the notification option. 
For information about configuring the notification option, refer to Notification on page 51. 

NOTE: The DX4000 does not support this feature.

The Emergency Notification feature is configured and operates independently of the mail feature. In this case, the DVR can be configured to send 
emergency reports but not mail. For information about setting up the mail feature, refer to Mail on page 51.

To use emergency e-mail notification, the DX4500/DX4600 Series DVR must be connected to a local area network (LAN) that maintains an SMTP 
mail server. The network must also be connected to either an intranet or the Internet depending on the location of the e-mail accounts to which 
you want to send notification. Consult your network administrator for information on configuring e-mail notification on your local network.

The Emergency Notification feature contains the following:

• Notification: Turns on and off the notification feature. 

• IP Address/Port: The remote computer’s IP address and port. Supported characters include 0.0.0.0–255.255.255.255.

• SMTP Port No.: The default port is 9003. Supported values include 025–65535.

1. In the Emergency section, click the Notification check box to enable emergency notification. 

2. To configure the Emergency Agent settings:
a. In the IP Address text box, click the first field in the box, and then type the first part of the remote computer’s IP address. Repeat this 

process to enter the complete IP address.

b. (Optional) By default, the system uses port 9002. To enter a different port number, click in the Port text box and type the new port 
number. 

3. Repeat step 2 to add multiple remote computers.

4. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.

Figure 44. Emergency Agent Settings
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System Setup
Some of the DX4500/DX4600 server options in the System page are not configured from the Client application and therefore should be configured 
before the unit is put into service. For information about configuring the system settings, refer to the DX4000 Operation manual.

The System page contains the following:

• Date/Time: The server date and time, time format, and time zone settings cannot be configured from the Client application. The Network 
Time Protocol (NTP), date format, and daylight saving features can be configured from the System page. For information about configuring 
the DX4500/DX4600 server date and time, refer to the DX4500/DX4600 Operation/Configuration manual. 

• Sound: All of the sound settings can be configured from the System page.

• Update: All of the update settings can be configured from the System page. The actual update process must be started locally from the 
server. The update process cannot be started using the Client application.

• User: Full user account administration is supported from the Client application.

• Hard Disk: The server format and auto delete features cannot be configured from the Client application. You can configure the overwrite, 
full warning, and event partition features from the Client application.

• Log Out: Auto user logout can be configured from the System page. 

1. In the Setup window, click the System page button . The System page opens. 

Figure 45. System Page Options
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DATE AND TIME
The date and time section contains the following:

• Date/Time: The date and time displayed in the Client application window is based on the date and time settings derived from and 
configured on the client computer. The server date and time cannot be configured from the Client application. For information about 
configuring the DX4500/DX4600 server date and time, refer to the DX4500/DX4600 Operation/Configuration manual. 

• Date Format: Although you can change the server date format at the Client application, the setting does not affect the date format 
displayed in the Client application window. The date format displayed in the Client application is based on the date format that is saved 
with the video as it is recorded. The date format configured at the DX4500/DX4600 server includes the following options: MM/DD/YYYY, 
DD/MM/YYYY, and YYYY/MM/DD. For information about configuring the server date and time, refer to the DX4500/DX4600 
Operation/Configuration manual.

NOTE: When the date format is changed at the Client application, it becomes effective at the server after you enter and exit the server’s 
Setup menu. 

• Time Zone: The system displays the time zone in which the DX4500/DX4600 is located. Time zones are determined by the number of 
hours they are offset from the Greenwich Mean Time (GMT). You cannot change the time zone from the Client application.

• Server: Allows you to select a private or public server. For the public server, the DVR obtains the average time from five public servers 
(rime.nist.gov, time-a.nist.gov, timeb.nist.gov, ntp.nasa.gov, and clock.isc.org).

• Private Time Server: The NTP server IP address or host name. Supports up to 24 characters including 0.0.0.0–255.255.255.255, a–z, A–Z, 
numerals 0 to 9, and special characters.

• Sync. Interval: Allows you to select how often the DVR’s time is synchronized with the NTP server.

• Daylight Saving: Ensures that the recorded video displays the correct time, reflecting the annual change to daylight saving time (DST). 
Select this setting if the DX4500/DX4600 is located in a state or country that observes daylight saving time. You must configure DST on 
both the DX4500/DX4600 and the computer on which the remote Client application is running. For information about the time zones, refer 
to Time Zone Conversion Chart on page 110.

• The DX4500/DX4600 must be turned on, connected to a network, and you must be logged on at the administrator level to configure network 
software settings. The DVR must also be restarted for any network configuration changes to take effect. Be sure you are not recording 
video that cannot be interrupted before changing the network settings.

1. On the System page:

a. Click the NTP check box to configure the DVR to synchronize with an external time source. 

b. Click the Date Format drop-down box, and then select a format.

NOTE: The time zone setting is displayed but is unavailable. This setting must be configured on the DX4500/DX4600 server. 

c. If NTP is selected, click the Server drop-down box, and then select a server. 

Figure 46. Setting the Date and Time

d. If you selected a private time server, the Private Time Server text box is available.

e. To specify the synchronization period, click the Sync Interval drop-down box, and then select an interval. 
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f. To configure daylight saving for the local server on which the DVR is installed:
(1) Click the Daylight Saving check box.

(2) Set the starting month, week, and day.

(3) Repeat the procedure in step f(2) to set the ending month, week, and day.

2. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.

SOUND
The DX4500/DX4600 sound feature allows you to configure the DVR to issue an audible sound in response to the activation of a button, an event 
(alarm or motion), or a system state. 

The sound feature contains the following conditions:

• Button: If set to ON, the system issues a single beep when a front panel or remote control button is pressed. 

• Alarm: If set to ON, the system continues to beep approximately once per second until the alarm event is acknowledged. 

• Motion: If set to ON, the system continues to beep approximately once per second until the alarm event is acknowledged. 

• System: If set to ON, the system beeps when a system action occurs.

1. In the Sound section, click the check box for each sound alert feature you want to initiate.

2. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.
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USER ACCOUNTS
User accounts are administered locally on the server or remotely over the network using the Client application. A user account consists of three 
items:

• ID: The user name is created by the system administrator. The default user name is admin.

The user name has the following guidelines:

– Characters: A to Z, a to z, numerals 0 to 9, and special characters.
– Name length: Up to 13 characters.

• Level: The three user levels are Administrator, Power User, and Normal User; the user is assigned a level when the user account is 
created. Table H describes the user levels and permissions granted to each level.

• Password: The login user password created by the system administrator. The default administrator password is admin, which can be 
changed.

The password has the following conditions:

– Characters: A to Z, a to z, numerals 0 to 9, and special characters.
– Password length: Must be between four and eight characters long.

The DX4500/DX4600 supports 10 user accounts including the default administrator account. 

Table H.  User Levels and Permissions

DVR Operation
User Level

Administrator Power User Normal User
Live View Yes Yes Yes
Search Yes Yes No
PTZ Yes Yes Yes
Alarm Off Yes Yes Yes
Instant Playback Yes Yes Yes
Instant Record Yes Yes Yes
Instant Backup Yes Yes No
Select Display Mode Yes Yes Yes
View System Log Yes Yes Yes
View System Information Yes Yes Yes
Setup Yes No No
Export Yes Yes No
Shut Down Yes No No
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CHANGING THE ADMINISTRATOR USER PASSWORD
NOTE: If the DX4000 password is changed from the DX4500/DX4600 Client, the Client application must be reconnected to the DX4000. 

1. In the User section, click admin to select the name.

Figure 47. Selecting the Administrator-Level User

2. To change the admistrator password:
a. Click Edit. The Password Confirm dialog box opens.

b. Click in the Password text box and type the current administrator password. 

c. Click OK. If the password is correct, the User Setting dialog box opens.

Figure 48. User Setting Dialog Box

d. In the Password text box, click and drag the current password entry, and then type a new password.

e. In the Confirm Password text box, click and drag the current password entry, and then retype the new password. The administrator 
password is changed. If the DVR is configured for e-mail notification, a message is sent to the designated user that the password has 
been changed.
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ADDING A NEW USER
1. In the User section, click Add. 

Figure 49. List of Users and Levels

2. The User Setting dialog box opens. To add a new user:
a. Click in the User ID text box and type the user name. 

b. Click in the Password text box and type the password.

c. Click in the Confirm Password text box and retype the password.

d. In the Level drop-down box, select the user level.

3. Click OK. The new name is added to the list.

Figure 50. Adding a User to the User List

4. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.
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EDITING A USER
The DX4500/DX4600 allows you to edit a user’s ID, password, and level. You can also edit the administrator’s password, but you cannot change 
the user ID.

1. In the User section, click the user name you want to modify.

2. To edit the user settings:
a. Click Edit. The User Setting dialog box opens. You can change any of the following: user ID, password, and level.

b. Click the text box for the user setting you want to change, and then add the next entry.

3. Click OK. 

4. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.

DELETING A USER
The DX4500/DX4600 allows you to delete any user except the administrator.

1. In the User section, click the user name you want to delete.

2. Click Delete. 

3. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.
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HARD DISK
The System menu Hard Disk option allows you to remotely configure the DX4500/DX4600 server overwrite and full warning features, and view 
the event partition setting, which cannot be remotely configured.

The Hard Disk feature contains the following: 

• Overwrite: 
– ALL: When the normal and event partitions are full, the system will begin overwriting those partition. In this case, the oldest recorded

data is overwritten first. The default setting is ALL. 
– NORMAL PARTITION: When the normal partition is full, the system will begin overwriting only the normal partition. The oldest

recorded data is overwritten first.
– EVENT PARTITION: When the event partition is full, the system will begin overwriting only the event partition. The oldest recorded

data is overwritten first.
– OFF: Blocks the overwriting of any partition.

• Full Warning: When the HDD has reached the configured percentage capacity, the system displays a warning message. The default 
setting is 70 percent.

• Event Partition (size): Specifies the percentage of the total hard disk space allocated for storing event-related recorded video. 
The remaining disk space is allocated for storing instant recorded video and normal recorded video. This option cannot be configured 
remotely using the Client application. 

To configure the Hard Disk options:

1. In the Hard Disk section, click the Overwrite drop-down box, and then select a setting. 

Figure 51. Overwrite Drop-Down Box

2. To configure the Full Warning feature, click the drop-down box, and then select a setting.

Figure 52. Full Warning Drop-Down Box

3. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.

WARNING:  If you change the event partition setting, the system will reformat all of the hard drives. All recorded video will be erased. 
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AUTO USER LOGOUT
The Client allows you to configure the time a user is automatically logged off from the Client application.

1. In the Log Out section, click the Auto User Logout drop-down box, and then select a setting.

Figure 53. Auto User Logout Drop-Down Box

2. To save changes:
a. Do one of the following:

• On the toolbar, click the Setup button . 

• On the toolbar, click the Search button . 

b. Click OK to save the changes and exit the setup window. If you click Cancel, you will exit the setup window and the changes will not 
be saved.
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Operation

Live Video
1. To view live video in the Client application window, click the Live View button . The Client application window opens.

Figure 54. Client Application Window

NAVIGATING VIEW PANES
1. On the toolbar, click a division button (1, 4, 9, 16, 1+5, or 1+7). The view panes are displayed in the selected division.

2. Click a pane to select it. The selected pane is highlighted with a red border.

Figure 55. Division Buttons

ASSIGNING CAMERAS TO VIEW PANES
To assign a camera to a view pane:

1. Do one of the following:

• In the site tree, click and drag a camera to a view pane. Repeat the process for up to 16 cameras. 
• In the site tree, click and drag the Cameras button to any pane. All cameras in the site tree are assigned sequentially to the panes.
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REPOSITIONING OR REPLACING CAMERAS IN VIEW PANES
Repositioning cameras: Cameras can be repositioned within a view panel by dragging a camera to a different pane. For example, in Figure 56, 
if camera 02 is dragged to pane 3, cameras 02 and 03 swap panes.

Replacing a camera: You can replace a camera in a pane with a camera from another remote site. For example, in Figure 56, if camera 08 in 
remote site DX4608 Bld 7 Lobby is dragged to pane 1, camera 01 in the DX4616 Local site is replaced by camera 08. 

NOTE: If you do not want a camera to be viewed, you must replace the camera with another one from a different remote site. If you have only 
one remote site, you cannot remove a camera from a pane.

Figure 56. Repositioning or Replacing a Camera
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Live View
CUSTOMIZING THE ON-SCREEN DISPLAY

To customize the on-screen display (OSD):

1. From the DX4500/DX4600 menu bar, choose View > OSD and then select the items you want to add to or delete from the OSD.

• Channel Number
• Site Name
• Camera Name
• Playback Time
• PTZ
• Audio
• Select All (displays all items in each pane)

2. From the menu bar, click View > OSD. The OSD submenu appears. By default, all of the OSD options are selected. The Client application 
allows you to customize the OSD settings, which apply globally for all panes and remote sites.

Figure 57. Client OSD Menu Options

3. Click an OSD feature to show or hide a label.

SEQUENCE DWELL TIME
Set the sequence dwell time to meet your security application requirements. Once you configure the dwell time, you have to manually start the 
sequence mode. The sequence dwell time has the following conditions:

• Channel/cameras are sequence in the order that they are assigned to panes.

• Channel/cameras are organized by groups: 
– Group 1, channels 1–4
– Group 2, channels 5–8
– Group 3, channels 9–12
– Group 4, channels 13–16

• Groups are sequenced if video is displayed on at least one of the four channels in a group. Video from the active channel is displayed and 
the Video Loss message or the Pelco logo displays in the application window for all remaining channels in the group. If no video is 
displayed for any of the channels in a group, either Video Loss or the Pelco logo displays in the application window.

SELECTING THE SEQUENCE DWELL TIME
1. From the menu bar, click View > Sequence (Dwell Time), and then select a dwell time.

Figure 58. Setting Sequence Dwell Time

2. On the toolbar, click a division button.
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STARTING AND STOPPING THE SEQUENCE VIEW
To start or stop the sequence:

1. On the toolbar, click the Cycle Views button . The button changes color and the cycle process either starts or stops.

FULL SCREEN VIEW
The Client application allows you to display video across the entire screen. In this view, the application site tree, menu bar and toolbar, PTZ 
control, timeline, and playback controls are not displayed.

1. Click the Full Screen button . The application displays across the entire screen.

Figure 59. Full Screen View

2. To return to the standard viewing size, right-click in the application.

SELECTING A LANGUAGE
The Client application allows you to select in what language the menu and dialog boxes are displayed. By default, the display language is 
English. You must restart the Client application for the new setting to take effect.

NOTE: The Client application does not administer the DX4004 language setting. The Client application displays the language for which the 
DX4004 server is configured. 

1. From the menu bar, click Language, and then select a language from the submenu. The DX4500_DX4600 Client dialog box opens.

Figure 60. Selecting a Language

2. Click OK. The dialog box closes.

3. To exit the Client application, click File > Exit. 
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To restart the Client application

1. On the task bar, click Start > All Programs > Pelco > PELCO Network Client > DX4500_DX4600 Client. The DX4500_DX4600 Client Password 
dialog box opens and the language is changed.

2. Click in the Password text box and type the default Client password 000000 (six zeros). 

3. Click OK. The DX4500_DX4600 Client application window is displayed.

4. To connect to and log on to a remote DVR server site:
a. In the site tree, click a remote site. The remote site is highlighted.

b. Do one of the following:

• From the DX4500_DX4600 menu bar, click File > Connect.

• In the site tree, right-click a remote site.

The Remote Login dialog box opens. The language in the dialog box is changed to the language you configured.

c. Click the User ID text box, and then type the assigned remote site user name.

d. Click the Password text box, and then type the assigned password.

e. Click OK. The system logs you on to the remote site. The language displayed in the Client GUI is changed. 

VIEWING HDD INFORMATION
The HDD Information dialog box displays data about DX4500/DX4600 server storage capacity (refer to Figure 61). 

The HDD space allocated to the normal and event partition is configured on the DX4500/DX4600 server using the Hard Disk option on the System 
menu. HDD overwrite and full warning options can be configured from the Client application. To view current storage capacity data, do the following:

1. From the OSD menu bar, click View > HDD Information. The HDD Information dialog box opens.

Figure 61. HDD Information Dialog Box

VIEWING THE SYSTEM LOG
The DX4500/DX4600 server monitors specific system-related events and stores that information in a log file, which can be viewed from the 
Client application. The following table represents a log of system events.

Table I.  System Events Log

Admin Login (Local) Configuration Imported HDD Damaged (HDD3) HDD Removed (HDD2)

Admin Login (Remote) Export Failed HDD Damaged (HDD4) HDD Removed (HDD3)

Admin Logout (Local) Export Finished HDD Formatted (HDD1) HDD Removed (HDD4)

Admin Logout (Remote) Export Started HDD Formatted (HDD2) Normal User Login (Local)

Backup Failed Factory Default Set HDD Formatted (HDD3) Normal User Login (Remote)

Backup Finished Guest Login (Remote) HDD Formatted (HDD4) Normal User Logout (Local)

Backup Started Guest Logout (Remote) HDD Removed (HDD1) Normal User Logout (Remote)

Configuration Changed HDD Damaged (HDD2)
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To view the system log:

1. From the menu bar, click View > Log View. The Log view dialog box is displayed. (Initially, the log is blank.)

Figure 62. Log View Dialog Box

2. To display log events for a specific day:
a. Click the Date drop-down box. The calendar opens.

b. To select a search date:
(1) Click either of the arrow buttons to select the month and year.

(2) Click the day of the week.

c. Click Search. The search results for the selected date are displayed. 

Figure 63. System Log Search Results

d. Use the scroll bars and arrow buttons to view events on the current, previous, or next page.
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PTZ
All user levels have access to the PTZ controls to operate and program cameras. PTZ functions can be controlled on the screen in live mode using 
the mouse. The PTZ control is available for cameras that support PTZ functions using Pelco C, Pelco D, or Pelco P protocols. It is also available for 
supported third-party dome cameras. For more information about configuring PTZ ports, refer to the DX4500/DX4600 Installation manual and the 
DX4500/DX4600 Server Operation/Programming manual.

Each channel/camera must be configured for PTZ operation. For more information about configuring a channel for PTZ operation, refer to
PTZ Communication on page 33. 

PTZ CONTROLS

1. On the toolbar, click the Live View button .

2. Click a PTZ-enabled camera in the view pane.

3. Place the mouse pointer in the middle of the camera’s view pane. The mouse pointer will change to a cross when the on-screen PTZ control 
is available.

Figure 64. On-Screen PTZ Control

4. Click and hold the left mouse button, and then drag the mouse pointer in the direction you want to move the camera. The pointer changes 
to a directional arrow, indicating the direction of the mouse. You can also use the PTZ OSD MENU to move the camera vertically and 
horizontally.

Figure 65. On-Screen PTZ Direction Arrows

5. Release the left mouse button when you have repositioned the camera to the desired location. 
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ADJUSTING THE CAMERA ZOOM, FOCUS, AND IRIS 
1. On the PTZ control, click the ZOOM (+) or ZOOM (-) button. 

Figure 66. PTZ Control Toolbar with Camera Lens Controls

PTZ PRESETS
A preset is a user-defined camera configuration and position, which you set up using the PTZ controls and focus commands (the camera’s auto 
focus option must be turned off). Only cameras that support positioning and programming using D, P, or supported third-party protocols can use 
this feature. The DX4500/DX4600 Series DVR can address up to 150 PTZ presets. Preset 95 is reserved for remote camera setup, and preset 99 is 
reserved for camera autoscan mode.

The PTZ controls are hidden in full screen view. In this case, select the standard view mode to display the PTZ controls. 

To switch between standard and full screen view: 

1. From the toolbar, click the Full Screen button . 

2. Right-click to return to the standard view mode.

Use the PTZ Control toolbar to work with presets.

Figure 67. PTZ Controls
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PROGRAMMING A PRESET
The following PTZ operating guidelines apply:

• To program or clear presets, preset tours, and patterns, the Set button must be engaged; clicking the Set button places the DVR in 
PTZ programming mode. 

• While in PTZ programming mode, multiple presets can be programmed until the Set button is pressed again.

To program a PTZ preset:

1. On the toolbar, click the Live View button .

2. Drag a camera from the site tree onto a view pane.

3. Click Set.

4. Using the on-screen PTZ controls and keypad, move the camera to the desired position and adjust the zoom setting.

5. Using the PTZ keypad, select a number for the new preset.

6. Click Preset to store the preset in the selected memory location.

7. Repeat steps 4–6 for each preset you want to program.

8. Click Set again to exit programming mode.

ACTIVATING A PRESET
Double- and triple-digit presets can be set or activated by pressing the first and second digits sequentially. For example, preset 20 can be 
selected by clicking the number 2 and then the 0 (zero) on the PTZ keypad. 

To activate presets, tours, and patterns, the Set button must be disengaged.

To activate a preset:

1. On the PTZ keypad, click a preset number (1–150) on the keypad.

2. Click Preset. The camera repositions to the new preset.

CLEARING A PRESET
To clear a preset:

1. On the PTZ keypad, click Set to enter programming mode.

2. Click the number of the preset you want to clear from the PTZ keypad.

3. Click the Clear button .

4. Repeat steps 2 and 3 to clear multiple presets.

5. Click Set to exit programming mode.
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PRESET TOURS
A preset tour allows a camera to move through a programmed sequence of PTZ presets. The DX4500/DX4600 tour advances sequentially through 
presets 1–16. The system pauses approximately four seconds between the end of the current preset and the start of the next preset. If the 
presets are programmed sequentially (1, 2, 3, 4, and so forth), the time period between presets is brief. If one or more the presets are not 
programmed sequentially, the time period between presets can be longer because the system still accounts for the four-second interval for the 
non-programmed preset memory location. For example, if presets 1 and 2 are programmed and presets 3–16 are not programmed, the system 
pauses approximately 54 seconds before starting preset 1. 

A preset tour will operate continuously until another PTZ control action is performed. At least one PTZ preset must be set in order to create a 
preset tour.

To activate a preset tour: 

1. Click Preset on the PTZ keypad to activate the tour.

To deactivate a preset tour:

1. Click the PTZ-enabled camera in the view pane.

2. Place the mouse pointer in the middle of the camera’s view pane. The mouse pointer will change to a cross when the on-screen PTZ control 
is available.

3. Click and drag the mouse pointer to move the PTZ-controlled camera. The preset tour stops.

PTZ PATTERNS
A pattern is a user-defined, viewable camera path with a specific beginning and end. Patterns are made up of a sequence of standard pan, tilt 
and lens commands. Patterns are stored in the internal memory of the PTZ device, such as a Spectra dome, connected to the DX4500/DX4600. 
Once defined, a pattern can be activated with a series of on-screen commands. A pattern will run continuously until it is deactivated. Certain PTZ 
devices, such as Pelco’s Spectra Series domes, will display an on-screen message about the amount of remaining available memory.

PROGRAMMING A PATTERN
To program a pattern:

1. In the site tree, drag a PTZ camera on to a view pane.

2. On the PTZ keypad, click Set to enter programming mode.

3. Using the PTZ keypad, select a number for the pattern (1–4).

4. Click Pattern.

5. Move the camera through a series of movements using the on-screen PTZ and focus controls.

6. Click Pattern.

7. Click Set.

ACTIVATING AND CLEARING A PATTERN
When activated, a pattern will repeat indefinitely until it is cleared, another pattern is set, or the on-screen PTZ control is moved.

To activate a pattern:

1. On the keypad, click a pattern number (1–4).

2. Click Pattern.

To clear a pattern:

1. On the keypad, click Set to enter programming mode.

2. Select a pattern number (1–4).

3. Click Pattern.

4. Click the Clear button .

5. Click Pattern again.

6. Click Set again to exit programming mode.
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ACCESSING PROGRAMMING FEATURES OF REMOTE CAMERAS
The Client application allows you to navigate the remote camera menu system using any of the following:

• PTZ OSD Menu controls, with limited functions.

• Keypad controls.

REMOTE CAMERA PROGRAMMING MENU
To access a programming menu for a remote camera:

1. On the toolbar, click the Live View button . 

2. Drag a remote camera from the site tree onto a view pane.

For certain camera models, you can also select preset 95 from the keypad to access remote setup mode.

3. To access remote setup mode, do one of the following:

• On the PTZ keypad, click the Program button . 

• Click Set, 9, 5, and Preset on the PTZ keypad.

4. To navigate up and down through the camera menu choices, do one of the following:
• Use the PTZ OSD Menu controls (refer to PTZ Control Toolbar on page 18). 
• Use the on-screen PTZ controls 
• Use the FOCUS (+) and FOCUS (-) buttons. 

5. To select an option from the camera’s on-screen menu, click the IRIS (+) button.

6. Click the IRIS (-) button to cancel an option or select the Exit command.

You can also use the on-screen PTZ controls to navigate through camera menus. Click and drag the mouse pointer up or down to move 
between menu options.

7. Click the IRIS (+) button to select the option.

Figure 68. Camera Setup Menu
C2675M-B (7/09) 73



SENDING AUXILIARY COMMANDS TO A DEVICE
The DX4500/DX4600 auxiliary feature allows you to control external equipment connected to the auxiliary outputs of Spectra domes or Esprit 
positioning systems. 

The Aux button selects the auxiliary mode. Buttons 1–4 select which of the camera’s auxiliary outputs to operate. Buttons 1–4 also operate as a 
toggle (on/off) each time they are clicked. 

For example, an Esprit equipped with a wiper uses Aux 1 to control the wiper. In this case, pressing Aux and then 1 sends a command to the 
Esprit to operate the wiper. You must configure the camera to establish how the camera responds to an auxiliary command. For detailed 
information about how a Spectra or Esprit camera system interprets auxiliary commands, refer to the documentation that accompanies your 
camera system. 

To send an auxiliary command:

1. On the DX4500/DX4600 keypad, click Set to enter the programming mode. 

2. Select the camera in the DX4500/DX4600 view panel to which you want to send the auxiliary command.

3. Click the Aux button. Buttons 1–4 are available.

Figure 69. Keypad Buttons 1–4 are Available

4. Click a button (1–4). The auxiliary function assigned by the camera for the selected button executes.
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Playback Video
The Client application allows all users to view live video. Users with administrator- and power-level permission are allowed to play back video. 
Video is played back one channel at a time. For information about view panes, refer to View Panes and Panels on page 16. 

NOTE: The DX4000 does not support the playback feature in the Live View mode; the playback control is unavailable.

RECORDED VIDEO AND AUDIO
NOTE: The DX4500/DX4600 has unique MPEG-4 recording characteristics. Images recorded at frame rates less than 7 ips when viewed using 
the DX4500/DX4600 Client Application software, might not be evenly distributed over a 1-second interval.

The Client application allows you to play back recorded video and audio in the Live View mode. Playing back video with audio has the following 
conditions:

• In Live View, only one channel at a time is played back.

• Your computer must be configured to play audio.

• The channel containing the video and audio must be selected.

PLAYBACK MODE
You can access the playback mode from the Live View mode. Use the timeline to set the date and time for selecting recorded video for playback. 

The timeline is displayed in a 24-hour format. While in Live View, you can select the time by dragging the timeline pointer along the timeline. The 
recorded video status bar is displayed in the timeline indicating the type of recording (normal, alarm, or motion). Blank areas in the timeline 
indicate the absence of recorded video. Click the Increase Timeline Detail and Decrease Timeline Detail buttons to see the 24-hour timeline in 
increments of 5 minutes to 1 hour. 

Figure 70. Playback Timeline in 24-Hour View

When video is played back, the on-screen display for played back video includes the date and time field, channel number, and remote site name.

Figure 71. Playback OSD

NOTE: The DX4000 does not support playback in the Live View mode.

1. On the toolbar, click the Live View button .

2. Do one of the following:
• Click the view pane of the camera from which you want to play back video.
• In the site tree, click and drag a camera to a view pane.
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3. In the timeline, do the following:
a. In the date drop-down box, select the day that you want playback to begin. For information about the Playback Timeline, refer to 

Playback Timeline on page 22.

The DX4500/DX4600 displays (in blue) the days on which data was recorded; the DX4000 does not. 

b. Select the time using the hours, minutes, and seconds boxes.

Figure 72. Date Drop-Down Box

4. On the Playback control, click the Play button . Playback starts and the audio button on the Playback control is disabled. For 
information about the Playback Controls, refer to Playback Controls on page 21.

5. (Optional) To activate audio, click the disabled Audio button . 

Figure 73. Disable Audio Button

SAVE VIDEO SCREEN CAPTURE TO JPEG FORMAT
The “Save to JPEG” menu command allows you to capture video. The menu command is available when video playback is paused in the Playback 
or Search modes. The screen capture is saved in JPEG format to a location on the remote client PC hard drive. You can specify the location or 
accept the default path: C:\DX45_4600 Exported files.

1. (Optional) Create a destination folder if you want the JFEG files stored to a specific location. Otherwise, do nothing (the JPEG files are 
stored to C:\DX45_4600 Exported files by default).

2. On the toolbar, click the Live View button .

3. Do one of the following:
• Click the view pane of the camera from which you want to play back video.
• In the site tree, click and drag a camera to a view pane.

4. In the timeline, select the day that you want playback to begin.

5. On the Playback control, click the Play button  to start playback, and then click the Pause button  when the video scene 
you want to capture is displayed. 

6. Use the playback controls to adjust the paused video scene. For information about the Playback Controls, refer to Playback Controls on 
page 21.
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7. From the menu bar, click File > “Save to JPEG.” The Export dialog box appears.
• To accept the default entries, click Save. The screen capture is stored in JPEG format at the default location.
• To select the saved path and file name: 

(1) In the Saved path text box, click the browse button , and then navigate to the folder.

(2) Click the destination folder.

Figure 74. Export Dialog Box_C2675M-B-1001.tif

(3) Click OK. 

(4) Click in the File Name text box and type the file name.

8. Click Save. The file is saved to the designated destination.
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Search Mode
DATE/TIME SEARCH WINDOW

The Date/Time Search window provides access to search capabilities. Available search methods for the DX4500/DX4600 include date/time, 
bookmark, event, and pixel search. The DX4000 also supports the date/time search feature. Users must have administrator- or power-level 
permission to search recorded video. 

The “Save to JPEG” menu command allows you to capture video. The menu command is available when video playback is paused in the Playback 
or Search modes. For information about the Save to JPEG command, refer to Save Video Screen Capture to JPEG Format on page 76.

1. On the toolbar, click the Search button . 

2. Do one of the following:
• Click the view pane of the camera from which you want to search recorded video.
• In the site tree, click and drag a camera to a view pane.

By default, the Search window opens in the Date/Time mode.
.

Figure 75. Client Search Mode
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Date/Time Search: Searches recorded video by date and time, and type of event. 

Bookmark Search: Allows you to search for recorded video previously bookmarked on the DX4500/DX4600 server.

Event Search: Allows you to specify the date and time of an event search: all, motion, or alarm. 

Pixel Search: Allows you to automatically search any 24-hour period of recorded video for changes in screen pixels. 

Search Control: Provides access to the index, thumbnail, POS, and pixel search controls.

View Window: Displays search controls and view pane.

Playback Control Panel: Provides buttons to control video playback including forward and reverse playback, and still image. 
Also provides controls for playback speed and volume.
Playback Timeline: Displays a 24-hour timeline marked with color-coded video events. Allows users with administrator- or power-
level permission to select a date and time for playback. 
Select All: The Client allows you to view playback video on multiple cameras in addition to the camera being searched. This feature is 
valuable if you want to examine a variety of views recorded at the time a specific event was detected.
• Selected: Plays back video for all visible view panes. 

• Deselected: Disables playback for all view panes except the channel being searched. This option must be deselected to play 
back video and audio.

Site tree: A top-down, hierarchical management of DX4500/DX4600 resources such as servers, cameras, alarms, and relays.
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DATE/TIME SEARCH
Date/Time Search is initiated from the main window. The Date/Time search feature has the following conditions:

• Entering the date and time: Use the Timeline calendar and time controls to specified the search criteria. 

• Searching event-specific video: While in the Live View mode, drag the Timeline pointer to a position in the timeline from which to 
initiate search. The Timeline provides a status bar that represents video recorded during the various recording modes (normal, alarm, and 
motion).

• Verifying the search device: To ensure that the proper camera channel is selected, check the camera information box above the 
playback timeline or verify that the desired view panel is framed with a thin red outline. 

• View format: Date and time video can also be displayed in full window view. 

• Select All: Allows you to view video from multiple cameras for a specified date/time.

To search video by date and time:

1. On the toolbar, click the Search button . 

2. Do one of the following:
• Click the view pane of the camera from which you want to search recorded video.
• In the site tree, click and drag a camera to a view pane.

3. In the Search control, click the Date/Time button . The search window is displayed.

4. Verify that Select All is selected to play back video for all channels.

5. In the timeline section, do the following:
a. In the date drop-down box, select the date.

b. Select the time using the hours, minutes, and seconds boxes.

c. (Optional) To position the timeline pointer in the status bar:
(1) Click the Increase and Decrease Timeline Detail buttons to expand or reduce the timeline in increments of 5 minutes to 1 hour. 

For the DX4000, the status bar has a 1-hour minimum: one minute of recorded data is displayed in the status bar as 1 hour.

(2) Click and drag the timeline pointer to a position.

(3) Click and drag the timeline scroll bar to reposition the status bar display.

6. Click the Play button  to begin viewing. 

Figure 76. Date/Time Search
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BOOKMARK SEARCH
Bookmark Search allows you to search video for a previously bookmarked camera on the DX4500/DX4600 server. 

To perform a bookmark search:

1. In the Search window, click the Bookmark button . The Bookmark Search window opens.

Figure 77. Bookmark Search

2. In the Bookmark Search section, click Search. All bookmarked data is displayed in the Bookmark Search table. To stop a search in progress, 
click Cancel.

Figure 78. Bookmark Search Results

3. To playback bookmarked video:
a. Click a search result. The snapshot of the video image is displayed in the view pane.

b. Use the Playback controls to view the video.
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EVENT SEARCH
The Client Event Search feature allows you to search for event recorded video. The Event Search feature has the following conditions:

• Event type: You can specify one of three event types: all (alarm and motion), alarm, or motion.

• Time constraints: Date and time are specified as part of the search criteria. If an event occurred earlier than the specified date and time, 
the event is not found.

• Device: The event search returns results for one device.

To perform a bookmark search:

1. In the Search window, click the Event button . The Event search window opens.

Figure 79. Event Search

2. In the Type drop-down box, select an event. 

3. In the site tree, click the camera for which you want to perform an event search. 

4. In the Event Search section, click Search. All bookmarked data is displayed in the Bookmark Search table. To stop a search in progress, 
click Cancel.

Figure 80. Event Search Results

5. Use the Playback controls to view the video.

M

82 C2675M-B (7/09)



PIXEL SEARCH
The Client application allows you to search recorded video for changes in screen pixels. (This feature can be configured to identify motion events 
even when motion detection has not been activated on a camera.) After the search is complete, the system displays the search results in a table. 
Each entry in the table contains the first image of recorded video for the specified date and time range period. 

To perform a pixel search: 

1. In the Search window, click the Pixel button . The Pixel Search window opens.

2. In the site tree, click the camera for which you want to perform a pixel search. 

3. In the timeline, do the following:
a. Select the date.

b. Select the time using the hours, minutes, and seconds boxes.

c. (Optional) To position the timeline pointer in the status bar:
(1) Click the Increase and Decrease Timeline Detail buttons to expand or reduce the timeline in increments of 5 minutes to 1 hour. 

(2) Click and drag the timeline pointer to a position.

(3) Click and drag the timeline scroll bar to reposition the status bar display.

4. In the Motion Setting section, click the Sensitivity drop-down box, and then select a sensitivity. Selecting a lower number decreases 
sensitivity and selecting a higher number increases sensitivity.

5. To define the motion area, do the following:
a. To reset the area, click Clear.

b. To define the area, in the Pixel Search window view pane, click and drag the search area(s).

• Hold down and drag the left mouse button to select an area.

• Hold down and drag the right mouse button to deselect an area.

6. Click Search. If motion is detected in the search area, the results are displayed in the Pixel Search table. To stop a search in progress, click 
Cancel.

7. Use the Playback controls to view the video.
.

Figure 81. Pixel Search
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BACKUP SEARCH
Backup search allows you to locate and playback video that was stored at the DX4500/DX4600 server. Video can be backed up to a USB drive, 
CD, or DVD. You can also copy the backed up data from the media to the Client PC’s hard drive. 

SELECT A BACKUP MEDIA DEVICE
1. On the toolbar, click the Search button . By default, the Search window opens in the Date/Time mode.

2. From the menu bar, click Backup Search. The Backup Search dialog box appears.

3. To add a backup media:
a. Click Add. The Add dialog box appears.

b. Type a name in the Name text box. 

c. (Optional) If you are accessing DX4000 backup data, select the DX4004 check box.

Figure 82. Accessing DX4000 Backup Data

d. Click the Open Browse button . The Open dialog box appears.

4. Select the media. 

Figure 83. Browsing to the Media

5. Click OK. The path is displayed in the Open text box of the Add dialog box.

Figure 84. Backup Search Name
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6. Click OK. The added media is displayed in the Backup Search dialog box. 

Figure 85. Media Displayed in Backup Search Dialog Box

7. Click the backup media you want to search, and then click Update. 

8. Click OK. The Backup Search dialog box closes, and the selected backup media is displayed in Search window site tree. The label “Backup” 
is displayed in the application window panes. Date/Time search is the default mode.

Figure 86. Backup Search Window
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SEARCH BACKUP MEDIA FOR DATA
The Client application allows you to view backup data in any of the search modes. 

1. In the site tree, click a camera. The selected channel pane is highlighted with a red border.

2. Do one of the following:
• To perform a Date/Time search, click the Play button . 
• To perform a Bookmark, Event, and Pixel search, click a search entry, and then click the Play button . 

3. Playback starts and the audio button on the Playback control is disabled.

4. To activate audio on the Playback control, click the Audio button . 

5. Click and drag the volume to decrease or increase the audio level.

For information about using the search mode, refer to Search Mode on page 96

EXIT BACKUP SEARCH MODE
1. From the menu bar, click End Backup Search. The DX4500/DX4600-Local Search mode is active.

2. On the toolbar, click the Live View button .
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Export Mode 
EXPORT WINDOW 

The Export window provides access to export capabilities. Users must have administrator- or power-level permission to export data. 

The export feature has the following conditions:

• Locating DX4500/DX4600 video for export: 
– Live View mode: Click the DVR server and camera channel for which data is to be exported, and then use the calendar and time

controls to locate the video.
– Search mode: Use this mode to locate data.
– Exporting video: In the Live View or Search mode, click the Export button. The Export dialog box opens allowing you to enter the

export criteria and data.

• Export data types: 
– DX4004: Data is only exported in the proprietary AVI format. You must use the DX4004 client to view the exported data.
– DX4500/DX4600: Data is exported in either AVI or native format. By default, data is exported in the AVI format. 

• AVI: You must use a viewer such as the Windows Media® Player to view this data. 

• Native: Use the DX4500_DX4600 Export Viewer to view this data.

• DX4500/DX4600 export time periods: There are five time periods to consider when exporting data:
– Standard time period: Data exported during a time not associated with the DST transition time frame.
– During DST: When exporting video for any duration between 01:00 and 01:59, the client application will prompt you to select a time

period for DST On (first hour) or DST Off (second hour). The default selection is DST Off.
– Before and during DST: For example, if you select a time period of 00:58 to 01:15, the client application will export data

beginning at 00:58, export data for the entire first hour (DST On), and export data for the second hour (DST Off) until 01:15. 
– During and after DST: For example, if you select a time period of 01:45 to 02:15, the client application will export data for the first

hour (DST On) beginning at 01:45, export data for the entire second hour (DST Off), and then stop exporting standard data at 02:1 5.
– Incorporating both DST hours (DST On, DST Off): If you select a time period that includes the full DST time frame (for example,

00:58 to 02:15), the client application will start the export process at 00:58, export the entire first and second hours (DST On and
DST Off) from 01:00. to 01:59:59. Data exporting will stop at 02:15.

• Locating DX4000 video for export: 
– Search mode: Use this mode to locate data.
– Exporting video: In the Search mode, click the Export button. The Export dialog box opens allowing you to enter the export criteria

and data.

• Export file size limit: The default size limit is 200 MB. During the export process, the system monitors the storage capacity of the 
destination folder. If the system detects that the storage capacity will exceed its limit, the export process is terminated and the message 
“Fail (Save folder is full.)” is logged in the status column for the respective export schedule.

To resolve this issue, you can do one or more of the following:

• Increase the size limit.
• Reduce the number of exported schedule files in the destination folder.
• Modify the Date/Time settings to reduce the size of the export schedule file.
• Store the exported file in another location.

• Viewing exported data:
– On the DX4500/DX4600 Client computer: Use the DX4500/DDX4600 Export Viewer to view data exported in the native format. You

can also use Windows Media player to view data exported in AVI format. For information about using the Export Viewer, refer to 
DX4500/DX4600 Export Viewer on page 27. 

– On a computer that the DX4500/DX4600 Client or Export Viewer is not installed: To view exported video in AVI format, the Pelco
DX4500_4600-AVI_Codec must first be installed. 
(1) Go to https://support.pelco.com/browse.php?fFolderId=577 and download the latest DX4500_4600-AVI_Codec file.

(2) Install the codec. 

(3) Use Windows Media player to view the exported data.
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1. On the toolbar, click the Export button .

.

Figure 87. Client Export Mode

Server: Displays the name of the device for which data is being exported.

Channel: Selects each channel from which to export data.

Audio: Allows you to export (On) or not export (Off) audio data. 

Date/Time: Configures the start/end date and time for exporting recorded video.

Save Path: Specifies the location to store the exported data.

Save Limit: Specifies the maximum allowable drive storage capacity in megabytes (1–64019 MB). 

Data Type: Supports exporting data in native or AVI format.

Export Table Buttons: 
• Add: Populates the export table with the an export schedule.
• Edit: Allows you to modify an existing export schedule.
• Delete: Permanently removes the selected export schedule from the export table.

Export Table: The location where export schedules are stored. 

Export Buttons: 
• Export: Starts the export process.
• Cancel: Stops the export process.
• Exit: Exits the Export dialog box back to the DX4500/DX4600 application window. Exiting the Export dialog box does not stop or 

cancel an active export process.
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EXPORTING STANDARD DATA
To export standard DX4500/DX4600 data:

1. In the Live View or Search mode, do one of the following:

• Click the view pane of the camera from which you want to export recorded video.
• In the site tree, click and drag a camera to a view pane.

2. To locate the data, in the timeline section, do the following:
a. In the date drop-down box, select the date.

b. Select the time using the hours, minutes, and seconds boxes.

c. (Optional) To position the timeline pointer in the status bar:
(1) Click the Increase and Decrease Timeline Detail buttons to expand or reduce the timeline in increments of 5 minutes to 1 hour. 

(2) Click and drag the timeline pointer to a position.

(3) Click and drag the timeline scroll bar to reposition the status bar display.

The date and timeline are accessible when the Export dialog box is opened.

3. On the toolbar, click the Export button . The Export dialog box opens.

4. To specify the export criteria, in the Export dialog box, do the following:
a. In the Server drop-down box, verify that the correct server is listed. The Server drop-down box is not available, but it does display the 

name of the server selected for exporting.

b. In the Channel section, click the button for each channel of exported data.

c. (Optional) In the Audio drop-down box, select On to export audio data for the selected channel. The default setting is Off.

d. In the Data/Time section, select a parameter, and then click the UP/DOWN button to set the start/end date and time.

Figure 88. Configuring the Date/Time Settings

e. (Optional) By default, exported schedules are stored in the following location: 

C:\Program Files\pelco\PELCO DX4500_DX4600 Client\Export Viewer

To store exported schedules in a different location, from the Windows environment, create the destination folder(s) before continuing 
to the next step.

f. To select the destination folder, do the following:

(1) Beside the Save Path text box, click the export path button . The Export Save Path dialog box opens. 

(2) Accept the default location, or navigate to another location and then select the folder. 

(3) In the Save Limit box, type the maximum storage capacity (in MB). 

g. In the Data Type drop-down box, select the data type.

5. To add the export schedule to the table, click Add. 

6. To start the export process, do the following:
a. In the export table, select a schedule.
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Figure 89. Export Dialog Box

b. Click Export. The export process starts. The status column changes to Complete if no issues arise during the export process. 

EXPORTING DST DATA
To export DX4500/DX4600 DST data:

1. In the Live View or Search mode, do one of the following:

• Click the view pane of the camera from which you want to export recorded video.
• In the site tree, click and drag a camera to a view pane.

2. To locate the data, in the timeline section, do the following:
a. In the date drop-down box, select the date.

b. Select the time using the hours, minutes, and seconds boxes.

c. (Optional) To position the timeline pointer in the status bar:
(1) Click the Increase and Decrease Timeline Detail buttons to expand or reduce the timeline in increments of 5 minutes to 1 hour. 

(2) Click and drag the timeline pointer to a position.

(3) Click and drag the timeline scroll bar to reposition the status bar display.

The date and timeline are accessible when the Export dialog box is opened.

3. On the toolbar, click the Export button . The Export dialog box opens.

4. To specify the export criteria, in the Export dialog box, do the following:
a. In the Server drop-down box, verify that the correct server is listed. The Server drop-down box is not available, but it does display the 

name of the server selected for exporting of data.

b. In the Channel section, click the button for each channel of exported data.

c. (Optional) In the Audio drop-down box, select On to export audio data for the selected channel. The default setting is Off.

5. Do one of the following:
• To export data between 01:00 and 01:59, refer to Exporting Data Recorded During DST on page 91. 
• To export data before the DST transition up to 01:59, refer to Exporting Data Recorded Before and During DST on page 91.
• To export data from 01:00 to after the DST transition, refer to Exporting Data Recorded During and After DST on page 92.
• To export data incorporating both the entire first and second hour (DST On and DST Off), refer to Incorporating Both DST Hours (DST On,

DST Off) on page 92
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EXPORTING DATA RECORDED DURING DST
1. To set the DST start date and time, do the following:

a. In the Data/Time section, set the respective DST start date.

b. Set the start time for 01:00 or later. Then set the end time later than the start time, up to 01:59. 

NOTE: The export duration is from 1–59 minutes within the 1-hour DST time period.

Figure 90. Configuring the DST Date/Time Settings

2. The default storage destination located at: C:\Program Files\pelco\PELCO DX4500_DX4600 Client\Export Viewer.

To store the exported schedule in a different location than the default path, do the following:

a. Beside the Save Path text box, click the export path button . The Export Save Path dialog box opens. 

b. Accept the default location, or navigate to another location and then select the folder. 

c. In the Save Limit box, type the maximum storage capacity (in MB). 

d. In the Data Type drop-down box, select the data type.

3. To add the export schedule to the table, do the following:
a. Click Add. The DST dialog box opens.

NOTE: The DST dialog box allows you to select the DST time period from which to export data. For information about exporting data from 
other time periods, refer to Export Window on page 87.

b. Accept the default setting (DST Off) or click the drop-down box and select DST On, and then click OK. The export entry is added to the 
export table.

4. To start the export process, do the following:
a. In the export table, select an export entry.

b. Click Export. The export process starts. The status column changes to Complete if no issues arise during the export process.

EXPORTING DATA RECORDED BEFORE AND DURING DST
1. To set the DST start date and time, in the Data/Time section, do the following:

a. Set the respective start/end date.

b. Set the start time before 01:00.

c. Set the end time between 01:00 and 01:59.

2. The default storage destination is located at: C:\Program Files\pelco\PELCO DX4500_DX4600 Client\Export Viewer.

To store the exported schedule in a different location than the default path, do the following:

a. Beside the Save Path text box, click the export path button . The Export Save Path dialog box opens. 

b. Accept the default location, or navigate to another location and then select the folder. 

c. In the Save Limit box, type the maximum storage capacity (in MB). 

d. In the Data Type drop-down box, select the data type.

3. Click Add. The export entry is added to the table. 

NOTE: The DST dialog box does not allow you to select the DST time period. For information about exporting data prior to and including a 
portion of the DST transition, refer to Export Window on page 87.
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Figure 91. Export Entry Added to the Export Table

4. To start the export process, do the following:
a. In the export table, select an export entry.

b. Click Export. The export process starts. The status column changes to Complete if no issues arise during the export process.

EXPORTING DATA RECORDED DURING AND AFTER DST
1. To set the start/end date and time, in the Data/Time section, do the following:

a. Set the respective start/end date.

b. Set the start time between 01:00 and 01:59.

c. Set the end time later than 01:59.

2. The default storage destination is located at: C:\Program Files\pelco\PELCO DX4500_DX4600 Client\Export Viewer.

To store the exported schedule in a different location than the default path, do the following:

a. Beside the Save Path text box, click the export path button . The Export Save Path dialog box opens. 

b. Accept the default location, or navigate to another location and then select the folder. 

c. In the Save Limit box, type the maximum storage capacity (in MB). 

d. In the Data Type drop-down box, select the data type.

3. Click Add. The export entry is added to the table. 

NOTE: The DST dialog box does allow you to select the DST time period. For information about exporting data within the DST transition, 
including data following the DST transition period, refer to Export Window on page 87.

4. To start the export process, do the following:
a. In the export table, select an export entry.

b. Click Export. The export process starts. The status column changes to Complete if no issues arise during the export process.

INCORPORATING BOTH DST HOURS (DST ON, DST OFF)
1. To set the start/end date and time, in the Data/Time section, do the following:

a. Set the respective start/end date.

b. Set the start time before 01:00.

c. Set the end time later than 01:59.

2. The default storage destination is located at: C:\Program Files\pelco\PELCO DX4500_DX4600 Client\Export Viewer.

To store the exported schedule in a different location than the default path, do the following: 

a. Beside the Save Path text box, click the export path button . The Export Save Path dialog box opens. 

b. Accept the default location, or navigate to another location and then select the folder. 

c. In the Save Limit box, type the maximum storage capacity (in MB). 

d. In the Data Type drop-down box, select the data type.

3. Click Add. The export entry is added to the table. 
92 C2675M-B (7/09)



NOTE: The DST dialog box does not allow you to select the DST time period. For information about exporting data prior to and including a 
portion of the DST transition, refer to Export Window on page 87.

4. To start the export process, do the following:
a. In the export table, select an export entry.

Click Export. The export process starts. The status column changes to Complete if no issues arise during the export process.

EXPORTING DATA FROM THE DX4000
To export data for a DX4000:

1. In the Live View mode, do one of the following:

• Click the view pane of the DX4000 camera from which you want to export recorded video.
• In the site tree, click and drag a DX4000 camera to a view pane.

2. Click the Search button . The Export button is available.

3. To locate the data, in the timeline section, do the following:
a. In the date drop-down box, select the date.

b. Select the time using the hours, minutes, and seconds boxes.

c. (Optional) To position the timeline pointer in the status bar:
(1) Click the Increase and Decrease Timeline Detail buttons to expand or reduce the timeline in increments of 5 minutes to 1 hour. 

(2) Click and drag the timeline pointer to a position.

(3) Click and drag the timeline scroll bar to reposition the status bar display.

The date and timeline are accessible when the Export dialog box is opened.

4. On the toolbar, click the Export button . The Export dialog box opens.

5. To specify the export criteria, in the Export dialog box, do the following:
a. In the Server drop-down box, verify that the correct server is listed. The Server drop-down box is not available, but it does display the 

name of the server selected for the exporting of data.

b. In the Channel section, click the button for each channel of exported data.

c. (Optional) In the Audio drop-down box, select On to export audio data for the selected channel. The default setting is Off.

d. In the Data/Time section, select a date/time parameter, and then click the UP/DOWN button to set the start/end date and time.

Figure 92. DX4000 Export Date/Time Settings

6. The default storage destination is located at: C:\Program Files\pelco\PELCO DX4500_DX4600 Client\Export Viewer.

To store the exported schedule at a different location than the default path, do the following:

a. Beside the Save Path text box, click the export path button . The Export Save Path dialog box opens. 

b. Accept the default location, or navigate to another location and then select the folder. 

c. In the Save Limit box, type the maximum storage capacity (in MB). 

NOTE: By default AVI is the exported data type. The Data Type drop-down box is unavailable.

7. Click Add, The export schedule is added to the table. 

8. To start the export process, do the following:
a. In the export table, select a schedule.
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Figure 93. Export Dialog Box

b. Click Export. The export process starts. The status column changes to Complete if no issues arise during the export process. 
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Recorded Video and Audio
NOTES:

• The DX4500/DX4600 has unique MPEG-4 recording characteristics. Images recorded at frame rates less than 7 ips, when viewed using the 
DX4500/DX4600 Client Application software, might not be evenly distributed over a one-second interval.

• The DX4500/DX4600 Client does not receive audio data from the DX4000. 

• Live audio does not stream from the DX4500/DX4600 server to the remote Client. You can only hear audio data in the playback mode.

The Client application allows you to play back recorded video and audio in the Live View mode. Playing back video with audio has the following 
conditions:

• In Live View, only one channel at a time is played back.

• Your computer must be configured to play audio.

• The channel containing the video and audio must be selected.

LIVE VIEW
The DX4000 does not support playback in the Live View mode.

To play back video and audio:

1. On the toolbar, click the Live View button . 

2. Do one of the following:
• Click the view pane of the camera from which you want to play back video and audio.
• In the site tree, click and drag a camera to a view pane.

3. In the timeline, select the date and time. 

4. On the Playback control, click the Play button . Playback starts and the audio button on the Playback control is disabled. 

Figure 94. Disabled Audio Icon

5. To activate audio, click the disabled Audio button . 
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SEARCH MODE
The Client application allows you to play back recorded video and audio in any of the search modes. Playing back video with audio has the 
following conditions:

• The DX4000 supports the playback feature (pause, stop, and play) in the search mode.

• Only one channel at a time is played back.

• Only the channel for playing back video and audio is selected.

• The Select All option must be deselected.

• Your computer must be configured to play sound.

To playback video and audio in the search mode:

1. On the toolbar, click the Search button . 

2. Do one of the following:
• Click the view pane of the camera from which you want to search recorded video.
• In the site tree, click and drag a camera to a view pane.

3. Click Select All to deselect the option.

4. Click a search method, and then perform the required steps to search a channel for video with audio. 

5. Do one of the following:
• To perform a Date/Time search, click the Play button . 
• To perform a Bookmark, Event, and Pixel search, click a search entry, and then click the Play button . 

6. Playback starts and the audio button on the Playback control is disabled.

7. To activate audio on the Playback control, click the Audio button . 

8. Click and drag the volume to decrease or increase the audio level.

PRINTING
The Client application allows you to select a camera pane and then print the displayed image. Printers must be configured before using the 
DX4500/DX4600 client print feature.

• DX4500/DX4600: 
– Live View: The print feature is available in the playback mode when playback is paused.
– Search: The print feature is available in the search mode when playback is paused.

• DX4000: 
– Live View: Playback is not supported in the Live View mode.
– Search: The print feature is available in the search mode when playback is paused.

PRINTING FROM THE LIVE VIEW MODE

To print from the DX4500/DX4600 Live View mode:

1. On the toolbar, click the Live View button .

2. Do one of the following:
• Click the view pane of the camera from which you want to play back video.
• In the site tree, click and drag a camera to a view pane.

3. Do one of the following:
• In the Playback control, click the Play button . 
• In the Playback Timeline control, select the date and time that you want playback to begin, and then click the Play button .

Video begins playing.

4. In the Playback control, click the Pause button . The Print button becomes available.
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5. To print the image, do the following:

a. On the toolbar, click the Print button . The Print dialog box appears.

b. Select the printer options.

c. Click OK. 

PRINTING FROM THE SEARCH MODE

To print an image from the Search mode: 

1. On the toolbar, click the Search button . 

2. Do one of the following:
• Click the view pane of the camera from which you want to search recorded video.
• In the site tree, click and drag a camera to a view pane.

3. Click Select All to deselect the option.

4. Do one of the following:
• DX4500/DX4600: Click a search method (Bookmark, Event, or Pixel), perform the required steps to search a channel for video with

audio, and then click the Play button . 

• DX4500/DX4600 and DX4000: To perform a Date/Time search, click the Play button .

Playback starts.

5. In the Playback control, click the Pause button . The Print button becomes available.

6. To print the image, do the following:

a. On the toolbar, click the Print button . The Print dialog box appears.

b. Select the printer options.

c. Click OK. 
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Remote Server Sites
ADDING REMOTE SITES

The Client application allows you to easily add remote sites to the site tree by using the Connection List dialog box. 

The Connection List dialog box contains the following items:

• Site Name: Allows you to create a unique name for the DVR. The site name is not displayed in the DVR server application window. 

NOTE: Using special characters in the site name other than those listed below will cause the export process to fail. 

– Characters: A to Z, a to z, numerals 0 to 9, and special characters `, ~, !, @, #, $, &, ( ), -, _, =, +, [ ], ., and { }
– Name length: Up to 18 characters.

• IP Address: Allows you to input the IP address of the DVR server. 

• Add: Adds a new DVR server to the connection list.

• Edit: Revises the DVR server site name or IP address. 

• Delete: Removes a DVR server from the list.

1. On the toolbar, click the Connection List button . The Connection List dialog box opens.

2. To add a DVR server to the list, click Add. The Connection Setup dialog box opens.

Figure 95. DX4500/DX4600 Connection Setup Dialog Box

3. Do one of the following:
• DX4500/DX4600: Go to step 4.
• DX4000: Select the DX4000 check box. The DX4000 Connection Setup dialog box opens.

Figure 96. DX4000 Connection Setup for Dialog Box

4. Click in the Site Name text box, and then type the site name.

5. Do one of the following:
• DX4500/DX4600: Go to step 6.
• DX4000:

(1) Click in the Password text box, and then type the DX4000 server password.

(2) In the Level drop-down box, select an operator level.

6. Click in the IP Address text box, and then type the DVR server IP address.

7. (Optional) By default, the Client application uses port 9001 for communicating with DVR servers. If the port is changed on the DVR server, 
click the Port text box, and then type the port number.
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8. Click OK. The entry is displayed in the Connection List dialog box.

Figure 97. Adding Servers to the Connection List

9. Click OK. The DVR server appears in the site tree.

Figure 98. Servers Displayed in Site Tree

EDITING A DVR SERVER SITE
The Client application allows you to edit a DVR server listing from the Connection List dialog box. You can modify the site name, IP address, and 
port number.

The connection setup has the following conditions:

• Site Name: 

NOTE: Using special characters in the site name other than those listed below will cause the export process to fail. 

– Characters: A to Z, a to z, numerals 0 to 9, and special characters `, ~, !, @, #, $, &, ( ), -, _, =, +, [ ], ., and { }
– Name length: Up to 18 characters.

• IP Address: Remote site IP address.

• Port number: By default, the port number is 9001. Before you change a port number:
– Consult your network administrator before assigning or changing port numbers. 
– Make sure that the ports are not blocked internally and are protected from external threats by a firewall. Client and server ports must

be identical.

• DX4000 check box: Must be selected if adding a DX4000 server.
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1. On the toolbar, click the Connection List button . The Connection List dialog box opens. 

Figure 99. Connection List Dialog Box

2. To edit a remote site:
a. Click the remote site you want to edit.

b. Click Edit. The Connection Setup dialog box opens.

Figure 100. Connection Setup Dialog Box

c. Click in a text box to modify the information. 

d. Repeat step 2c for each entry you want to modify.

e. Click OK to save the edits. The new information is displayed in the Connection List dialog box.

Figure 101. Editing a Remote Site Name
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DELETING A REMOTE SITE

1. On the toolbar, click the Connection List button . The Connection List dialog box opens.

2. Click the remote site you want to remove, and then click Delete. The remote site is deleted from the Connection List dialog box. 

3. Do one of the following:
a. To accept the change, click OK. The remote site is deleted.

b. To cancel the change, click Cancel. The remote site is not deleted.
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Supplemental Applications

Emergency Agent
GETTING STARTED

Welcome to the DX4500/DX4600 Emergency Agent application. The Emergency Agent works with networked DVRs to alert users when one or 
more particular channels detect an alarm, motion, disk full, administrator password change, video loss, or power on/off event. The Emergency 
Agent runs on a networked client PC and is installed as part of the Client application installation.

Ensure that the following requirements are met before starting the Emergency Agent application:

1. At least one active DX4500/DX4600 Series DVR is available on your network and your computer is set up to access it. Consult your network 
administrator for more information.

2. The Emergency Agent notification is set up on one or more DX4500/DX4600 Series DVRs and your PC has been configured to receive 
emergency notifications. For information about setting up Emergency Agent notification, refer to the DX4500/DX4600 Operation/
Programming manual. 

STARTING THE EMERGENCY AGENT
1. On the task bar, click Start > All Programs > Pelco > PELCO Network Client > DX4500_DX4600 Emergency Agent. The DX4500_DX4600 

Emergency Agent application starts and the Pelco logo appears in the Windows task bar.

Figure 102. Starting the Emergency Agent

DISPLAYING THE EMERGENCY AGENT MENU
The USB mouse is used to access Emergency Agent GUI controls and features. Menu commands can be selected with the mouse, or you can 
press Alt + C to select the command.

1. On the Windows task bar, click the Pelco logo . The Emergency Agent menu is displayed. 

Figure 103. Emergency Agent Menu

REAL-TIME EVENT MONITORING
Once the Emergency Agent is activated, an event detected by DX4500/DX4600 server will cause a 5-second message to display in the lower-right 
area of the screen. If you click the message the Received Message dialog box opens. In addition to real-time monitoring of events, all event 
notifications sent to the Client computer are logged for future viewing.

Figure 104. Emergency Agent Message
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EMERGENCY AGENT SETUP

SELECTING THE LANGUAGE
1. From the Emergency Agent menu, click Language. The language submenu opens.

2. Click a language to select it.

3. On the Windows task bar, click the Pelco logo . The Emergency Agent menu opens. 

Figure 105. Emergency Agent Menu

4. From the menu, click Check Message Box. The Received Message dialog box opens and displays text in the selected language.

CONFIGURING THE NETWORK PORT
The Emergency Agent application allows you to change the network port used to receive notifications. 

To change the port:

1. On the Received Messages dialog box, click the PORT button . The Option dialog box opens. 

Figure 106. Option Dialog Box

2. Click in the Emergency Agent Port No. text box and type a new port number. The default port number is 9002.

You should keep the default port setting unless there is a conflict on your network. Consult your network administrator before changing 
network port settings. If the port number must be changed, the number must be an integer between 1025–65535. 

3. Click OK.
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REAL-TIME EVENT MONITORING

RECEIVED MESSAGES
1. Do one of the following:

• On the Windows task bar, click the Pelco logo .
• Click the Emergency Agent Message within five seconds.

The Emergency Agent menu opens. 

Figure 107. Received Messages Window

VIEWING MESSAGE DETAILS

In the Received Messages Event Report list, click a report to view the message details.

Event Report List: Lists the event reports. The list can be sorted by clicking any of the column heads.

Message Area: Displays the message for the selected event port.

CLOSE: Closes the received Messages window, but does not exit the Emergency Agent application.

DELETE: Deletes the event report highlighted in the Event Report list. Once deleted, the event report cannot be recovered.

REFRESH: Refreshes the Event Report list adding new reports to the list.

SEARCH: Opens the Message Search dialog box, which searches for event reports by event type and date.

PORT: Opens the Option dialog box to verify or change the port number.
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PERFORMING A MESSAGE SEARCH
Over time, the Emergency Agent will accumulate event information in a list. This list can be searched and previously logged events can be 
viewed.

To search for previously logged events:

1. In the Received Messages dialog box, click the SEARCH button . The Message Search dialog box opens.

2. Specify the search criteria.
a. To search by event type, click the Event Search check box.

(1) In the Event Search section, select the types of events.

b. To search by date, click the Date Search check box. Access the DATE drop-down box to select the start and ending date for the search.
(1) In the Date section, use the drop-down boxes to select the event start and end dates.

3. Click Search.

Figure 108. Selecting Event Type Search Criteria

DELETING AN EVENT REPORT
1. In the Received Messages Event Report list, click a report.

2. Click DELETE. The event report is deleted from the list and cannot be recovered.

3. In the Received Messages dialog box, click CLOSE. The Received Messages dialog box closes, but the Emergency Agent application is 
still active.

EXITING THE EMERGENCY AGENT

1. On the Windows task bar, click the Pelco logo . The Emergency Agent menu opens. 

2. Click Exit to close the Emergency Agent application. To receive notification messages, the Emergency Agent application must be restarted.
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Web Client
GETTING STARTED

Welcome to the DX4500/DX4600 Web Client application. The DX4500/DX4600 Web Client allows you to view live video, operate the PTZ 
features of cameras attached to DX4500/DX4600 Series DVRs, and capture video displayed in the view panel. Using a standard Web browser, 
you can remotely monitor up to 16 cameras for up to 16 DX4500/DX4600 servers simultaneously. 

Web client features include:

• Live viewing of up to 16 cameras simultaneously

• Ability to monitor cameras from multiple DX4500/DX4600 sites

• Multiple screen division options including one, four, and sixteen panel views

• Full PTZ control

• Runs on multiple platforms using a standard Web browser

• Capture video displayed in the view panel and save the file to disk

NOTE: The DX4500/DX4600 Web Client is only compatible with Internet Explorer®.

Installation
The first time you use a Web browser to connect to a DVR server, an ActiveX® control application is downloaded and installed on your local 
computer. This control facilitates usage of the Web client’s interactive features.

1. Start Internet Explorer.

2. Enter the server IP address you want to connect to.

3. Click Go. The ActiveX installation message appears. 

Figure 109. ActiveX Installation Message

4. Click the ActiveX installation message. The submenu opens. 

Figure 110. ActiveX Submenu
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5. Click Install ActiveX Control. The Security Warning dialog box opens.

Figure 111. Security Warning Dialog Box

6. Wait while the ActiveX controls are downloaded to your PC and your browser software is updated. 

STARTING THE WEB CLIENT
To start the DX4500/DX4600 Web Client, cookies must not be blocked by your browser. Refer to Internet Explorer Help for instructions on 
enabling cookies. User names and passwords are case sensitive; type them exactly as shown.

NOTES: To avoid potential problems and conflicts with your computer’s video subsystem, run only one instance of the Client application or Web 
Client at a time.

To activate the DX4500/DX4600 Web Client application:

1. Start Internet Explorer.

2. Enter the server IP address you want to connect to. The Remote Login dialog box opens.

Figure 112. Remote Login Dialog Box

3. Enter the server User Type.

4. Enter the server Password.

5. Click OK. The DX4500/DX4600 Web Client opens in the Web browser. 
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Once the Web Client is running, cameras can be assigned to view panes, live video can be displayed, and PTZ features can be controlled on a 
single screen.

Figure 113. Web Client Application Window

EXITING THE DX4500/DX4600 WEB CLIENT
To exit the Web Client application, select File > Close from the browser window.

Site Tree

Divisions

Cycle Views

Full Screen

Snapshot

PTZ ZOOM 

PTZ FOCUS 

PTZ IRIS

PTZ Keypad

PTZ OSD MENU
View Pane Within the View Panel
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REMOTE SITES

LOGGING ON TO A REMOTE SITE
After a connection to a remote site has been established, you must log on with a valid user name and password. 

To log on to a remote site:

1. Click a remote site from the site tree.

2. Right-click the site name and then select User Log-In from the submenu.

3. Enter a user name and password for the remote site.

LOGGING OFF FROM A REMOTE SITE
To log off from a remote site, right-click the site name in the site tree, and then select User Log-Out from the quick-menu. 

VIEWING VIDEO
For viewing live video and operating PTZ cameras, refer to PTZ on page 69. Some of the features shown in Operation on page 63 section may not 
be available in the Web Client.

Configuring View Panels
The DX4500/DX4600 Web Client can display up to 16 cameras simultaneously, on a single screen.

To establish the arrangement of view panels on the Web Client screen, select a screen division button from the toolbar. The following table 
describes the toolbar.

Table J.  Web Client Toolbar

Single Division View: Displays video from one camera.

4 Division View: Displays video from four cameras simultaneously.

9 Division View: Displays video from nine cameras simultaneously.

16 Division View: Displays video from sixteen cameras simultaneously.

6 Division View: Displays video from six cameras simultaneously; one large pane and five smaller images.

8 Division View: Displays video from eight cameras simultaneously; one large pane and seven smaller images.

Cycle Views: Turns on and off window cycling. 

Full Screen: Displays video from one camera, expanding the application window to occupy the entire screen. Click the right 
mouse button to exit full-screen view. 

Video Capture: Initiates a screen capture of the current view panel. The file is automatically named (using the 
YYYYMMDD_hhmmss format) and stored at c:\DX4X00 (default location).
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Appendix

TIME ZONE CONVERSION CHART
To determine your time, add the standard, daylight saving, or summer time to the Universal Time (UT).

Table K.  Time Zone Conversion Chart 

Time Zone
Standard 
Time

Daylight Saving 
and Summer Time

International Date Line East (IDLE) +12 hours 
New Zealand Standard Time (NZST) +12 hours 
New Zealand Time (NZT) +10 hours 
Guam Standard Time (GST) +10 hours 
Australian Eastern Standard Time (AEST) (AEDT) +10 hours +11 hours
Australian Central Standard Time (ACST) (ACDT) +9.5 hours +10.5 hours
Japan Standard Time (JST) +9 hours 
China Coast Time (CCT) +8 hours 
Australian Western Standard Time (AWST) +8 hours 
India Standard Time (IST) +5.5 hours 
Russian Zone 3 +4 hours 
Baghdad Time (BT) +3 hours 
Russian Zone 2 +3 hours 
Moscow Time (MSK) (MSD) +3 hours +4 hours
Eastern European Time (EET) (EEST) +2 hours +3 hours
Russian Zone 1 +2 hours 
Central Europe Summer Time (CEST) +2 hours
Central European Time (CET) +1 hour 
Middle European Time (MET) +1 hour 
Swedish Winter Time (SWT) 0 hours 
Greenwich Mean Time (GMT) 0 hours 
Universal Time (UT) 0 hours 
Western European Time (WET) (WEST) 0 hours +1 hour
British Summer Time (BST) +1 hour 
Irish Summer Time (IST) +1 hour 
West African Time (WAT) -1 hour 
Newfoundland Standard Time (NST) (NDT) -3.5 hours -2.5 hours
Atlantic Standard Time (AST) (ADT) -4 hours -3 hours
Eastern Standard Time (EST) (EDT) -5 hours -4 hours
Central Standard Time (CST) (CDT) -6 hours -5 hours
Mountain Standard Time (MST) (MDT) -7 hours -6 hours
Pacific Standard Time (PST) (PDT) -8 hours -7 hours
Alaskan Standard Time (AKST) (AKDT) -9 hours -8 hours
Hawaiian Standard Time (HST) -10 hours 
International Date Line West (IDLW) -12 hours 



PRODUCT WARRANTY AND RETURN INFORMATION

WARRANTY
Pelco will repair or replace, without charge, any merchandise proved defective in
material or workmanship for a period of one year after the date of shipment.

Exceptions to this warranty are as noted below:
• Five years:

– Fiber optic products
– TW3000 Series unshielded twisted pair (UTP) transmission products
– CC3701H-2, CC3701H-2X, CC3751H-2, CC3651H-2X, MC3651H-2, and

MC3651H-2X camera models
• Three years:

– Pelco-branded fixed camera models (CCC1390H Series, C10DN Series,
C10CH Series, IP3701H Series, and IX Series)

– EH1500 Series enclosures
– Spectra® IV products (including Spectra IV IP)
– Camclosure® Series (IS, ICS, IP) integrated camera systems
– DX Series digital video recorders, DVR5100 Series digital video recorders,

Digital Sentry® Series hardware products, DVX Series digital video
recorders, and NVR300 Series network video recorders

– Endura® Series distributed network-based video products
– Genex® Series products (multiplexers, server, and keyboard)
– PMCL200/300/400 Series LCD monitors

• Two years:
– Standard varifocal, fixed focal, and motorized zoom lenses
– DF5/DF8 Series fixed dome products
– Legacy® Series integrated positioning systems
– Spectra III™, Spectra Mini, Spectra Mini IP, Esprit®, ExSite®, and PS20

scanners, including when used in continuous motion applications.
– Esprit Ti and TI2500 Series thermal imaging products
– Esprit and WW5700 Series window wiper (excluding wiper blades).
– CM6700/CM6800/CM9700 Series matrix
– Digital Light Processing (DLP®) displays (except lamp and color wheel). The

lamp and color wheel will be covered for a period of 90 days. The air filter is
not covered under warranty.

– Intelli-M® eIDC controllers
• One year:

– Video cassette recorders (VCRs), except video heads. Video heads will be
covered for a period of six months.

• Six months:
– All pan and tilts, scanners, or preset lenses used in continuous motion

applications (preset scan, tour, and auto scan modes).

Pelco will warrant all replacement parts and repairs for 90 days from the date of
Pelco shipment. All goods requiring warranty repair shall be sent freight prepaid
to a Pelco designated location. Repairs made necessary by reason of misuse,
alteration, normal wear, or accident are not covered under this warranty.

Pelco assumes no risk and shall be subject to no liability for damages or loss
resulting from the specific use or application made of the Products. Pelco’s liability
for any claim, whether based on breach of contract, negligence, infringement of
any rights of any party or product liability, relating to the Products shall not exceed
the price paid by the Dealer to Pelco for such Products. In no event will Pelco be
liable for any special, incidental, or consequential damages (including loss of use,
loss of profit, and claims of third parties) however caused, whether by the
negligence of Pelco or otherwise.

The above warranty provides the Dealer with specific legal rights. The Dealer may
also have additional rights, which are subject to variation from state to state.

If a warranty repair is required, the Dealer must contact Pelco at (800) 289-9100 or
(559) 292-1981 to obtain a Repair Authorization number (RA), and provide the
following information:

1. Model and serial number
2. Date of shipment, P.O. number, sales order number, or Pelco invoice number
3. Details of the defect or problem

If there is a dispute regarding the warranty of a product that does not fall under
the warranty conditions stated above, please include a written explanation with
the product when returned.

Method of return shipment shall be the same or equal to the method by which the
item was received by Pelco.

RETURNS
To expedite parts returned for repair or credit, please call Pelco at (800) 289-9100
or (559) 292-1981 to obtain an authorization number (CA number if returned for
credit, and RA number if returned for repair) and designated return location.

All merchandise returned for credit may be subject to a 20 percent restocking and
refurbishing charge.

Goods returned for repair or credit should be clearly identified with the assigned
CA or RA number and freight should be prepaid.

The materials used in the manufacture of this document and its components are compliant to the requirements of Directive 2002/95/EC.

This equipment contains electrical or electronic components that must be recycled properly to comply with Directive 2002/96/EC of the European Union 
regarding the disposal of waste electrical and electronic equipment (WEEE). Contact your local dealer for procedures for recycling this equipment.
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REVISION HISTORY

Manual # Date Comments
C2675M 8/07 Original version.
C2675M-A 5/08 Documents v1.1 corrections, DST operation, and new information about the export feature.
C2675M-C 7/09 Added new features and updated illustrations including backup search, multi-event scheduling, and Pelco C protocol support. 
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